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1. はじめに 

 

1-1. Scaffold DIA とは 

 

Scaffold DIA は、DIA 定性/定量プロテオミクス解析において、RAW データ読み込みから解析、結果 

表示までの一連作業がワンパッケージで行えるソフトウェアです。Scaffold DIA の機能に ついて、以下の  

4つ(5つ)のキーワードで説明いたします。 

 

・Identify 

・Organize,Summarize 

・Quantify 

・Visualize 

 

 

■Identify 

事前に作成した DDA ピークリストデータのライブラリと比較して DIA データからタンパク質を同定する

事ができます。また FASTA 配列から作成された仮想ピークパターンに対して検索を行う事もできます。  

同定ペプチド・タンパク質は FDR を基に再評価されるほか、同定タンパク質はシェアペプチドの状況により

グループ化やクラスタリングが行われます。 

 

■Organizeと Summarize 

 取り込んだデータに対して属性グループを定め、属性値を付与する事ができます。定められた属性を基に

定量値や検定結果をまとめる事ができます。 

 

■Quantify 

 各ペプチドの代表的なイオンフラグメントに基づいて行われます。サンプル間の正規化が行われ、     

各ペプチドの定量値が合計されてタンパク質の定量値が算出されます。定量値に基づいて様々な検定・  

統計解析を実施する事ができます。 

 

■Visualize 

 表示するタンパク質はフィルター機能などで調整可能です。タンパク質のリストには、Gene Ontology の

情報を併記することができます。検定・統計解析を行った結果を表示する各種方法に対応しています。  

定められた属性ごとに計算される定量値は、選択肢を変更する事でインタラクティブに表示内容を変更  

する事ができます。 
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1-2. インストール・ライセンシングについて 

  

 インストール並びにライセンシングについては、別資料「ScaffoldDIA インストール手順 .pdf」を       

ご覧ください。インストール DVD内にも含まれています。 

https://www.matrixscience.co.jp/supportpdf/scaffold/ScaffoldDIA_install.pdf 

 

 

1-3. 本資料の構成について 

 

本資料では Scaffold DIA の基本的な使い方について説明しています。 

 

2,3 章では 解析対象のデータとその取り込みについて、 

4章では ソフトウェア画面のメニューや全体像の説明、 

5章～10章では画面左側にあるパネルの切り替えで表示させる各画面の説明、 

11章では使用可能な検定と Significant Levelの設定、 

12章ではタンパク質のグループ化に関する設定、 

13章では出力可能な report、 

14章ではライブラリフリーサーチ作成の手順、 

15章では Gene Ontologyについて、 

16章ではデモデータや参考資料などその他の情報について、 

 

それぞれご紹介しています。 

 

https://www.matrixscience.co.jp/supportpdf/scaffold/ScaffoldDIA_install.pdf
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2. データの準備 

 

この章では Scaffold DIAに取り込む測定データの特徴について説明しています。 

 

 

2-1. 取り込むデータの種類 

 

 これから DIA測定を始める方に対して解析のヒントを記した資料が「Designing a DIA Method」 

https://www.proteomesoftware.com/documentation/scaffold_dia_ms_methods/ 

です。ご興味がございましたらご参照ください。 

 

 

2-2. DIAと DDAの比較 

 

DDA ワークフローの場合、再現性とカバレージを両立させようとすると測定しなければならない    

データ数が膨大となります（Fig.2-1）。DIA は測定の数を減らしながらカバレージを落とさず網羅的に解析

ができる、バランスの良い測定手法と言えます(次頁 Fig.2-2)。 

 

 

 

 

Fig.2-1 DDA 解析におけるデータ収集 

https://www.proteomesoftware.com/documentation/scaffold_dia_ms_methods/
https://www.proteomesoftware.com/documentation/scaffold_dia_ms_methods/


 ©2023  Scaffold DIA マニュアル マトリックスサイエンス株式会社 All Rights Reserved      7 

 

 

 

 

 

2-3. Scaffold DIA ワークフロー 

 

 Scaffold DIA は DIA データ内とライブラリにおけるフラグメントパターンを比較する事で、ペプチド/

タンパク質の同定と定量を同時に行います。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.2-2 DIA 解析におけるデータ収集 

Fig.2-3 Scaffold DIA のワークフロー 
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検索時に参照する「ライブラリ」については、主に以下の 4つの方法に対応しています。 

- FASTAファイルを使う方法 

FASTA フォーマットのタンパク質配列ファイルを使って解析できます。ピーク強度情報は予測  

しません。 

- Prositライブラリを使う方法（DLIBを使う方法） 

FASTA フォーマットのタンパク質配列情報から、プログラム ”Prosit”を介して作成された      

スペクトルライブラリに対して検索が可能です。ファイル拡張子は .dlib です。ライブラリは、

Proteome Software社サイト 

https://support.proteomesoftware.com/hc/en-us/articles/360035151172-Prosit-

Derived-Spectral-Libraries-for-Scaffold-DIA-Searches 

から取得できるほか、ご自身で FASTAファイル元に Prositのサイト  

https://www.proteomicsdb.org/prosit/ 

で作成し得られたファイル（拡張子が .csv または .spectronaut）を使用する事もできます。  

ライブラリ作成について詳しい手順を 14 章(P.94～)にまとめたので、作成の際はそちらをご参照 

ください。 

- BLIBを使う方法 (Skylineまたは Scaffold 5 経由) 

DDA 解析時に得られたピークリストライブラリです。ソフトウェア Skyline や Scaffold 5 上で 

作成できます。Skylineなどの他ソフトウェアから得た iRTDBファイルも併せて取り込む事ができ、

RT のアライメントに利用する事ができます。blib 以外に、dlib, traML,MSP,SPTXT といった   

フォーマットにも対応しています。 

- ELIBを使う方法 

Scaffold DIAが作成したクロマトグラムのライブラリで、BLIB,DLIBや FASTAを使った解析の

結果得られた、ピークと RT なども含むクロマトグラム情報が組み合わさったエントリーの      

ライブラリです（Fig.2-4）。 

⚫ ELIBと DLIBは同じフォーマットで実質中身が同じであり、相互互換があります。Scaffold の

ELIB用/DLIB用オプションはどちらも利用可能です 

 

 

一方 Scaffold DIAでは poolのサンプルと個別のサンプルを組み合わせた解析法にも対応しています。

例えば pool されたサンプルを FASTA や BLIB(DDA 由来のピークライブラリ)に対して検索を行い その

結果から ELIB を作成し、個々の DIA データをその ELIB に対して検索させることができます(Fig.2-5、 

次頁図)。 

Scaffold DIA では様々な解析方法に対応しています。データ取り込みについては「3章データ取り込み」

にて詳しく説明しています。 

Fig.2-4 ELIB 作成例 

https://support.proteomesoftware.com/hc/en-us/articles/360035151172-Prosit-Derived-Spectral-Libraries-for-Scaffold-DIA-Searches
https://support.proteomesoftware.com/hc/en-us/articles/360035151172-Prosit-Derived-Spectral-Libraries-for-Scaffold-DIA-Searches
https://www.proteomicsdb.org/prosit/
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2-4. Scaffold DIA データ処理の流れ 

 

データ処理の流れを図示したのが、次頁図「Fig.2-6 Scaffold DIA データ処理の流れ」です。Scaffold 

DIA では raw データの変換に、外部プログラムの 「ProteoWizard」 を利用しています。その後、 読み

込んだデータを解析に中心的な役割を果たすのが「EncyclopeDIA 」というプログラムです。

https://bitbucket.org/searleb/encyclopedia/wiki/Home 

ペプチドの特定とスコアリング、保持時間のアライメント、Percolator によるスコアリング結果の再評価、

ペプチド同定の決定とタンパク質同定、各種計算結果のサンプル横断的な補正、定量、といった処理が 

EncyclopeDIA上で行われます。EncyclopeDIA はワシントン大学のMacCoss教授の研究室（旧所属）で

Proteome Software社の製品開発担当者 Brian Searle が作成・公開しているプログラムです。 

次々項以降に、以下の処理・計算について詳しく説明しています。 

 

- RAWファイルの変換 

- ペプチドの同定 

- Decoyデータの作成方法 

- ペプチドのスコアリング 

- 保持時間のアライメント 

- ペプチドの定量 

 

 

 

Fig.2-5 個別の DIA データと pooled データを組み合わせた解析 

https://bitbucket.org/searleb/encyclopedia/wiki/Home
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■ RAWファイルの変換 

Scaffold DIA では raw データの変換に、 ProteoWizard で提供されている「MSConvert」を

利用しています。Scaffold DIA で対応する RAW データは、MSConvert の対応に依存します。

MSConvertでは rawデータを共通 XMLフォーマットである「mzML」フォーマットに変換します。

変換時の一時ファイルはソフトウェア内で「Processing directory」として定義されたフォルダに 

保存されます。使用後は基本的にファイルを削除しますが、もしデータを残すよう指定していた  

場合、データは削除されず残ります。 

 

■ ペプチドの同定 

ペプチドの同定などにはプログラム「EncyclopeDIA」 が使われています。同定に際し測定  

データとライブラリーデータとの比較が行われます。ライブラリーデータには前述のように     

幾つかのバリエーションがあります。 

 

・BLIB  : DDA測定データのピークリストライブラリ : Skylineや Scaffold から出力 

・FASTA : タンパク質のアミノ酸配列情報から単純なピークパターンを計算 

・Prosit Library:アミノ酸配列情報から計算された理論ピークリスト。RTや強度情報を含む 

・ELIB  : Scaffold DIA で検索された過去の解析データ。RTや強度情報を含む 

 

■ Decoy データの作成方法 

 EncyclopeDIA の中で Percolator の計算を行う際、decoy データベースを使用します。decoy

の配列は末端を固定して target エントリーのペプチドを逆向きにする事で作成します。ピークに 

ついては逆向きにした配列が来るべきフラグメントピークの位置に合うように m/z をシフトし、 

強度についてはそのまま利用します。 

 

■ ペプチドのスコアリング 

EncyclopeDIA によって計算される主要なスコア、 [primary peptide score]は、純粋に      

プレカーサー分離ウィンドウ内の実測ピークとライブラリ内のピークとのマッチングから評価    

します。DIA では共溶出ペプチドの存在が当たり前である事を踏まえ、マッチしなかったイオンに

関してペナルティを与えていません。１つのウィンドウ内で複数のペプチドフラグメントピークとの

マッチを評価します。[primary peptide score] はX!TandemのHyperScoreと概念が似ていて、

測定したスペクトルとライブラリのスペクトルにおけるフラグメントの強度の加重ドット積に、    

マッチしたイオンの数の階乗をかけたものです。そのほか関連スコアとしてデルタ CN や        

フラグメントイオンの精度、プレカーサーマスの精度、保持時間精度などを評価したスコアも計算 

されます。 

 

 

[次頁に続きます] 
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■ 保持時間のアライメント 

EncyclopeDIA では同定されたペプチドすべてについて、x 軸がライブラリ内にある保持時間、

y 軸が測定値の保持時間のプロットを取ります(Fig.2-7)。続いてカーネル密度推定(ヒストグラム

から計算された曲線)により 1000x1000 グリッドデータに補正され線が引かれます。サンプル間

にわたりアライメントの調整が行われる段階では、構成要素のペプチド数が最も多いサンプルを      

リファレンスサンプルと定め、そのリファレンス内のペプチドを基準に他のサンプルのペプチドの

保持時間を調整します。保持時間のずれが大きく異常値と判定された各サンプルのペプチドに 

ついてはマッチの再評価が試みられます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

■ ペプチド定量 

  ペプチドの定量はフラグメントのピーク強度のみを定量値として利用しており、プリカーサーピークの

強度の値は使っていません。 

 

 

  

Fig.2-7 RT Alignment 
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3. データの取り込み 

 

この章では Scaffold DIAでのデータ取り込みについて説明いたします。 

 

 

3-1. 取り込み可能な rawファイルのフォーマット 

 

Scaffold DIA では データ取り込みの際、ProteoWizardで提供されているプログラム

「msconvert.exe」を利用しており、取り込み可能な rawファイルのフォーマットもそのプログラムの対応に

準じます。読み込み可能なファイルをまとめたのが以下の表です（Tab.3-1 Scaffold DIAで取り込み可能

なファイルフォーマット）。例として挙げたメーカーのファイル読み込みについてはよく確認していますが、 

それ以外のメーカーでも rawデータの読み込みが可能である他、 mzMLに変換されたデータについても

基本的に読み込みが可能です。 

 

各社メーカーのファイルフォーマット [読み込みなどがよく確認されているもの] 

装置メーカー ファイルフォーマット 

AB/SCIEX *.wiff (.wiff.scanも同じフォルダに置く事) 

Agilent *.d (ディレクトリ) 

Thermofisher scientific  *.raw 

オープンフォーマット (原理的には mzML フォーマットになっていればデータの読み込みが可能) 

HUPO Proteomics Standards Initiative mzML *.mzML 

 

 

 

 

3-2. コマンドラインでの利用 

 

Scaffold DIA では、サーバーでの利用や自動化処理を目的として、コマンドラインでも利用できます。  

実行時にワークフローの定義を行っているファイルと rawファイルを読み込みます。コマンドラインの    

インターフェースを利用する場合、「ScaffoldDIABatch.exe」プログラムを利用します。「-help」で使い方に

関する説明文が現れます。また以下の HELPサイトを利用すると実行したい内容を引数として指定    

するにはどうするか、より簡単に理解できます。 

https://www.proteomesoftware.com/annotated-scafml 

ご不明な点はサポートへお問い合わせください。 

 

 

Tab.3-1 Scaffold DIA で取り込み可能なファイルフォーマット 

https://www.proteomesoftware.com/annotated-scafml
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3-3. ライブラリマネージャー 

 

検索を行う際に使用するライブラリについて、ダウンロード・ライブラリ作成と管理・選択を行うのが     

ライブラリマネージャーです。ライブラリマネージャーを通じて検索時に複数のライブラリを選択したり、

FASTAファイルとの紐づけを予め指定したりすることも可能です。 

 

 

 

ライブラリマネージャーは以下の 3つの操作のいずれかで起動できます。 

 

- 「File」メニューから「Open Library manager」を選択 

- ツールバーの「ライブラリマネージャー」アイコン をクリック 

- 「Workflow」ダイアログの「reference file」選択ボックスで「Choose...」をクリックすると表示される 

ドロップダウンから「Library manager」を選択 

 

画面下の各ボタンについて、以降より詳しく説明します。 

 

“Add Library”  

新たにライブラリを追加します。ボタンを押すとファイル選択ダイアログが現れます。ライブラリファイル

(FASTA以外)を選択して Scaffold DIAに取り込みますが、この段階では対応する FASTAファイルとの 

紐づけが行われていません。紐づけを行うには、ライブラリを選択して右クリックし、「Associate with 

FASTA」を選択して、対応する FASTAファイルを選んでください(次頁 Fig3-2)。紐づけを行う事で、   

ライブラリ検索におけるペプチドとタンパク質の連結が行われ、タンパク質全長の配列や分子量の情報を 

取得できるようになります。 

 

Fig.3-1 ライブラリマネージャー ダイアログ 
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“Remove Library”   

作成したライブラリを Library Managerから削除します。 

 

“Create Library”  

検索を行いその結果を DIAの検索結果ライブラリ(ELIB)として保存する事ができます。検索後作成  

されたライブラリは自動的に Library Managerに、対応する FASTAファイル情報と共に登録されます。 

 

“Download”  

Proteome Software社が作成した、Prosit由来のピークリストファイルをダウンロードしセットする事が

できます。ボタンを押すと Fig3-3 のようなダイアログが現れます。①で生物種を選ぶと、データベースの

詳細情報と共に URLが③に自動的に入力されます(次頁 Fig.3-4)。④でファイルダウンロード先並びに  

ダウンロード後のファイル名を選択すると”Download”ボタンを押すことができるようになります。この時、

ライブラリに対応する FASTAファイルも同時に取得します。 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.3-2 ライブラリマネージャー ライブラリと FASTA の紐づけ操作 

Fig.3-3 ライブラリマネージャー “Download”ダイアログ 
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3-4. 解析の開始とワークフローダイアログ 

 

新しく解析を始めるには、ソフトウェアを起動後以下のどちらかの操作を行います。 

 

- メニューの File -> New 

- Ctrl + N 

- メニューバー下にあるアイコン  をクリック  

 

新しいファイルが作成されると最初に現れるのが「ワークフローダイアログ」です(Fig.3-5)。ダイアログの 

タイトル欄には「Load Data」と表示されています。 

 

 Fig.3-5 ワークフローダイアログ 初期表示画面 

Fig.3-4 ライブラリマネージャー “Download”ダイアログ ライブラリの詳細情報 



 ©2023  Scaffold DIA マニュアル マトリックスサイエンス株式会社 All Rights Reserved      17 

ワークフローダイアログでは検索実行に必要な各種パラメータを設定します。パラメータの多くは    

デフォルト値が定められていますが一部パラメータはユーザーが指定する必要があります。ユーザーが  

指定しなければならないパラメータが残っている項目については、▲で警告が表示されています。 

 ワークフローダイアログは以下３つのタブから構成されています。 

 

1. Search タブ  (3-4-1,P.17 ～) 

検索のタイプ、検索対象のライブラリや配列ファイル、許容可能な誤差範囲などを指定します。 

2. Analysis タブ (3-4-2,P.24 ～) 

検索後、どのような条件のタンパク質を結果に表示するかに関するパラメータを指定します。 

3. Advanced タブ (3-4-3,P.25 ～) 

定量計算の条件や一時ファイルの置き場所などを指定します。 

 

使用初期でよくわからない場合、とりあえずは Searchタブで▲が表示され入力を促されている項目の

み記入してください。また各タブのフッター部分に共通して表示される「Load Workflow From File …」

と「Save Workflow As …」は、このワークフローダイアログで定義する内容について、 予めファイルと 

して保存した内容を呼び出したり、逆に定義した内容をファイルとして保存したりする際に利用します。 

 

以降、ワークフローダイアログの各タブの内容について、詳細を説明します。 

 

 

3-4-1. ワークフローダイアログの Search タブ 

 

Searchタブでは検索対象のライブラリ（FASTA,BLIB,DLIB,ELIBなど）、配列ファイル、許容可能な  

誤差範囲などを指定します（Fig.3-3）。 

 

ダイアログ上部には２つの選択肢があります。 

- Search a reference library 

- Create a chromatogram library and search against it 

 

「Search a reference library」は、FASTAあるいは BLIB、DLIB,ELIB（この中のいずれか 1種類）に 

対する検索を行います。開発元が特に推奨している手軽さと同定力を兼ね備えたライブラリが Prositに 

よって作成されたライブラリ（DLIB）です。PrositはWilhelmと Kusterのグループによって開発された、

ペプチドのフラグメントと保持時間を予測する深層学習アルゴリズムです。Proteome Software社では  

多くの生物の Prositライブラリを提供しており、Library Managerからファイルをダウンロードできます

し、以下WEBサイトからダウンロードする事も可能です。作成に関する詳しい内容は、以下 URLまたは 

本資料の 14章(P.93～)をご参照ください。 

 

https://support.proteomesoftware.com/hc/en-us/ articles/360035151172-Prosit-Derived-Spectral-

Libraries-for-Scaffold-DIA-Searches 

 

https://support.proteomesoftware.com/hc/en-us/articles/360035151172-Prosit-Derived-Spectral-Libraries-for-Scaffold-DIA-Searches
https://support.proteomesoftware.com/hc/en-us/articles/360035151172-Prosit-Derived-Spectral-Libraries-for-Scaffold-DIA-Searches
https://support.proteomesoftware.com/hc/en-us/articles/360035151172-Prosit-Derived-Spectral-Libraries-for-Scaffold-DIA-Searches
https://support.proteomesoftware.com/hc/en-us/articles/360035151172-Prosit-Derived-Spectral-Libraries-for-Scaffold-DIA-Searches
https://support.proteomesoftware.com/hc/en-us/articles/360035151172-Prosit-Derived-Spectral-Libraries-for-Scaffold-DIA-Searches
https://support.proteomesoftware.com/hc/en-us/%20articles/360035151172-Prosit-Derived-Spectral-Libraries-for-Scaffold-DIA-Searches
https://support.proteomesoftware.com/hc/en-us/%20articles/360035151172-Prosit-Derived-Spectral-Libraries-for-Scaffold-DIA-Searches


 ©2023  Scaffold DIA マニュアル マトリックスサイエンス株式会社 All Rights Reserved      18 

もう 1つの選択肢、「Create a chromatogram library and search against it」は最初に FASTA 

あるいは BLIB,DLIBに対する検索を行い、そこで得られた情報を元に作成された DIAの解析結果を   

ライブラリ化した ELIBに対して別のデータを検索する、2段階検索です（P.8の Fig2-5 の検索方法に 

対応しています）。1回目と 2回目の検索させるデータとの間で、保持時間に関する関連性がある事が  

求められます。 

 

2種類の検索のどちらかを選ぶかに伴って指定が必要なパラメータが連動してユーザーに提示     

されます。前出の Fig3-5は「Search a reference library」を選んだ場合、以下 Fig.3-6が     

「Create a chromatogram library and search against it」を選んだ場合です。 

 以降、２つの選択肢を選んだ場合それぞれにおけるパラメータ入力画面について説明いたします。 

 

  

 

 

■ Search a reference library を選択した場合 

 

ダイアログ内に「Experimental Data Search Parameters」という領域が現れます。その行を     

クリックするとパラメータ入力画面が現れます(次頁 Fig.3-7)。各パラメータを入力後、画面下の    

「Load Data」ボタンを押すことで解析が開始されます。 

この領域について、画面を３つのパーツに分けて説明いたします。 

Fig.3-6 ワークフローダイアログ Search タブ初期表示画面 
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Fig.3-7 ワークフローダイアログ Search タブ  

3 

2 

1 
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・ Reference Library と Protein Sequence Database 

「Reference」検索対象となる Libraryを選択します。ライブラリマネージャーから選ぶ方法と、 

DLIBや BLIBなどのファイルを直接選択する方法があり、後者の場合はピークリストリファレンスに 

対応する FASTAファイルを下の「Protein Sequence Database」で選択する必要があります。 

 

・iRT Database File  [必須ではない] 

 BLIBを検索対象とし、かつ Skylineから該当ファイルを出力している場合、Scaffold DIAの計算に  

そのファイルを保持時間情報として利用できます。” Choose” でファイルを選択します。 

 

・Fragmentation 

  CID / HCD / ETD から選択します。ペプチドの同定並びに定量の際に対象とするイオンシリーズが 

変わります。CID,HCD は b,y イオン、ETDは cと z イオンを同定や定量時に利用します（CIDは特定の

ケースにおいて同定時 y イオンしか考慮しない事がありますが、その時も定量には b イオンを使用します）。 

  

・ Precursor / Fragment / Library Fragment : Tolerance 

測定値と、理論値またはライブラリ値 との許容誤差範囲です。 単位として Daと ppm どちらでも  

選択可能です。 

 

・Digestion Enzyme 

実験で用いたペプチド切断方法（酵素）です。None Specificの場合任意の場所での切断パターンを考慮 

しますが、その場合はmissed cleavageの設定を、(考慮したい最大ペプチド残基長-1) の数値を設定する

ようにしてください。 

 

Fig.3-8 ワークフローダイアログ Search タブの 1 部分 

 

1 
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・Peptide Length 

 検索対象とするペプチドの長さです。 

 

・Peptide Charge 

 検索対象とするペプチドの電荷です。 

 

・Max Missed Cleavages 

理論ペプチド作成の際、切断対象のアミノ酸を何回無視したペプチドを作成するかの設定です。 数が 

多いと理論ペプチド数が増えます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

・Modifications 

  考慮する修飾です。FASTAを対象とする検索の場合、このリストで指定した修飾を考慮した理論値を 

作成して検索します。一方 BLIBや ELIBなど、ピークリストへの検索の際は、ライブラリに含まれる修飾に

関する情報を極力拾い上げてこの欄に修飾情報を表示します。 

 

・Peptide FDR Threshold  

  Percolator 適用によって計算されるペプチド FDRの閾値です。 

 

 

Fig.3-9 ワークフローダイアログ Search タブ  の 2 部分 

2 
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・Data Acquisition Type 

DIAの測定での Precursor Isolation Window の幅に関する設定です(Fig.3-9)。 

 

- Non-overlapping Windows:両端のオーバーラップ領域がない 

- Overlapping Margins : オーバーラップ領域がある場合、ウィンドウ幅と合わせてマージン幅を

指定 

- Staggered Windows : 一度 MS/MS の測定をした後、ウィンドウ幅を半分ずらして再度

MS/MSの測定を行う手法。 

 

 

 

 

 

 

 

 

 

 

・ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Precursor Window Size 

 ウィンドウ幅を、ファイル情報から取得し設定するかユーザーが特定するか選びます。通常

は ”Determine from raw file”を選択してください。 

 

 

Fig.3-9 ワークフローダイアログ Search タブ  の ② 部分 

Non-overlapping Windows 

Overlapping Windows 

Staggered Windows 



 ©2023  Scaffold DIA マニュアル マトリックスサイエンス株式会社 All Rights Reserved      23 

 

 

 

 

 

 

 

・

Experimental Data Files 

  検索対象となる rawファイルを選択します。 

 

 

■ Create a reference library and search against it を選択した場合 

 

ダイアログ内に「Chromatogram Library Creation Parameters」と「Experimental Data 

Search Parameters」の２つのセクションが現れます。最初の検索で ELIBを作成し、その ELIBに対して

本命のサンプルデータを検索します。「Chromatogram Library Creation Parameters」については 

前述の通常検索とパラメータの内容が同じです。後段にあたる、「Experimental Data Search 

Parameters」の「Experimental Data Files」で、検索対象とする本命のサンプルデータを指定して   

ください（Fig.3-12）。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.3-11 ワークフローダイアログ Search タブ  の 3 部分 

Fig.3-12 Search タブ Experimental Data Search Parameters 画面 

3 
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3-4-2. ワークフローダイアログの Analysis タブ 

 

Analysisタブでは、ペプチドに関する検索後、その結果から同定タンパク質に選定しグループ化する  

際に利用されるパラメータです。 

 

 

・Shared Evidence Clustering  

 シェアペプチドを持つ類似タンパク質のグループ化についての設定です。以下 3段階があります。 

- Perfect shared evidence protein groups 

- Moderate shared evidence clusters 

- Any shared evidence clusters 

 

上に行くほどクラスター化させるためにペプチドセットの組み合わせ条件が厳しくなり、逆に下は緩く  

なります。一番上の「Perfect～」なら、完全にペプチドセットが同じタンパク質でないとグループ化されませ

ん。逆に一番下の「any～」では１つでもシェアペプチドがあればグループ化されます。 

詳細は本資料 12章「タンパク質のグループ化、クラスター化」(P.89～)をご覧ください。 

 

・Target Protein FDR 

 表示させるタンパク質について FDRの閾値を設定します。ペプチドの FDR設定とは異なる、タンパク質

の FDRであることにご注意ください。 

 

・Minimum Number of Peptides 

表示させるタンパク質の条件として、アサインされているユニークペプチドの最低数を設定します。 

 

 

Fig.3-13 ワークフローダイアログ Analysis タブ 
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3-4-3. ワークフローダイアログの Advanced タブ 

 

Advanced タブでは、データ処理に関する基本的な部分に関する設定を行います(Fig.3-14)。 

 

 

・Processing Directory 

  Scaffold DIA がデータ処理を行う際に利用する一時的なファイルの保管場所です。フォルダの選択と、   

ラジオボタンで計算に利用した一時ファイルの扱いを決定します。デフォルトでは計算の度にサブフォルダ

を作成してその下に一時的なファイルを作成し、計算後にそのファイルを消すように設定しています。   

ファイルを消さないようにしたり、サブフォルダでなく作成フォルダに直接ファイルを書き込むように設定

したりする事ができます。 

 

・Minimum/Maximum Number Of Quant Ions 

DIAの定量計算に使うフラグメントイオンの数について上限と下限を設定しています。Scaffold DIAの

定量計算はフラグメントピークのみを対象とします。共溶出の影響による精度の低下を避ける目的で、  

すべてのフラグメントを使うわけでなく設定した上限個数までしか使用しません。Scaffold DIAでは   

デフォルトで使用するフラグメントピーク数を 3以上 5以下として設定しています。 

 

・Percolator Training Set Size, Percolator Training Set Threshold 

  Percolator 計算に関するパラメータです。通常はデフォルト値を使用してください。 

 

・Filter RT 

 RTのフィルターです。明示的に解析に不要な領域がある場合に指定してください。なお、データ取り込み

の最初の段階で rawファイルから .dia ファイルを作成する際にのみ機能するため、inputデータが.dia 

ファイル(rawやmzMLから Scaffold DIA用に変換したファイル)の場合は機能しません。 

  

Fig.3-14 ワークフローダイアログ Advanced タブ 
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4.  Main画面 

 

4-1. Scaffod DIA メイン画面について 

 

Scaffold DIAは、以下 6つのパネル（画面左側）から構成されています。 

 

- Organize   (5章) 

- Samples   (6章) 

- Proteins   (7章) 

- Visualize  (8章) 

- Analysis   (9章) 

- Publish    (10章) 

 

以降に続く 5章～10章ではそれぞれのパネルについて説明しています。 

この章では、どのパネルを選択していても表示される、画面の周辺にあるタイトルバーやメニューバーな

どについて詳しく説明しています(Fig.4-1)。 

 

 

 

  

メニューバー 
Summarization 

データのまとめ単位 

表示タンパク質のフィルターリング 

 

各画面への切り替え 

FDR 計算値表示 

表示タンパク質のフィルターリング 

Fig.4-1 Scaffold DIA メイン画面 
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4-2. メニューバー 

 

メニューバーの各項目(Fig.4-2) について説明します。 

 

 

 

メニュー 各項目の内容 

File 

 

・ New – 新たな解析ファイルを作成します。詳細は 3章「データの取り込み」を 

ご覧ください。 

・ Open – Scaffold のファイル「*.sdia」を開きます。 

・ Close – 現在開いているファイルを閉じます。 

・ Save – 現在開いているファイルを上書き保存します。 

・ Save As - 現在開いているファイルを別名で保存します。 

・ New Chromatogram Library – 検索時に使用する新たな Chromatogram

ライブラリ(ELIBファイル)を作成するダイアログを開きます。 

・ Open Library Manager – Library Managerダイアログを開き、現在登録 

されているライブラリの調整ができます。 

・ Convert Raw Files to DIA Files – rawファイルを dia ファイルに変換する

処理を行うためのダイアログを開きます。 

・ Print – 現在開いている画面を印刷します。 

・ Print Preview - 現在開いている画面を印刷する前に、印刷後のイメージを 

表示します。 

・ Exit - ソフトウェアを終了します。 

 

Edit 

 

・ Copy - 現在開いている画面の主な情報をまとめてクリップボードにコピー  

します。データはタブ区切りです。他ソフトウェアにテキスト情報として      

貼り付けることができます。 

・ Find - 現在開いている画面内でキーワード検索をするダイアログを表示     

します。 

・ Edit Go Terms Options – GO情報について表示項目を選択したり、参照の

ファイルを設定したりします。 

・ Preferences – Scaffold DIA を使用する際に必要な各種基本設定      

（メモリ、プロセッサー数、proxy、msconvertプログラムの指定など）を     

確認・変更します。 

 

Fig.4-2 Scaffold DIA メニューの内容 
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View 
・ Color Options – 定量値の表示数字の大小を表す色について、設定を変更  

するダイアログを表示します。 

・ Advanced Filter -メイン画面にあるフィルター画面では指定しきれない  

細かい条件を指定したフィルターリングを実行します。 

・ Show/Hide Columns - 各画面で表示されている列の内容を調整します 

・ Navigate – 表示されているパネル画面内のタブを切り替えます（タブを直接

クリックしても切り替わります） 

・ Summarization – メイン画面内の「Summarization」と同じく、 データを

まとめる単位（階層構造）を切り替えます。 

・ Display Type – メイン画面内の「Display type」と同じく、表示する数字の

内容を切り替えます。 

・ Cluster Value Suppression – 類似タンパク質をまとめるクラスター化を

した際、一覧表にクラスター並びに各構成タンパク質の定量値をどのように 

表示するか設定します。 

・ Log Intensities – 定量値表示を底が 10の Log表示に切り替えたり元に戻

したりします。 

・ Organize View ～ Publish View – メイン画面の左側のパネルと同じく、

各パネルへ切り替え・移動できます。 

Experiment 

 

・ Apply Thresholding –各ペプチドについて同定の信頼度を求めるパラメー

タです。設定値の Percolator q-value閾値を上回らないペプチドは定量計算

に使用されません。デフォルトは No boundで閾値設定はありません。 

・ Protein Clustering - 類似タンパク質をグループ化してまとめる

「Clustering」について、まとめる基準の設定をします(→12章、P.89～)。 

・ Apply GO Terms – (Samples画面) 予め設定した GOデータベース    

ファイルに照合しタンパク質に GO情報を付与します（→15章、P.108～）。 

・ Import Attributes Files - 各サンプルデータ間の階層・属性を定義した

「Attribute file」を読み込みます。 

・ Quantitative Analysis –定量値を使って検定を行ったり、検定の有意基準

についての設定を行ったりします。 

・ Clear User Peptide Validation - 定量計算を行う際に行った各種設定を

リセットして、デフォルト値に戻します。 

Export ・ Export Attributes Files -各サンプルデータ間の階層・属性を定義した

「Attribute file」を設定ファイルとして出力します。 

・ Export Samples Report to Excel ～ Export Workflow – 解析データ

を様々な観点でまとめたレポートを Excelで読み込み可能な CSVフォーマッ

トで出力します。詳細は P.91～.「13.Report」をご覧ください。 

・ Run SQL Query for Export - SQLコマンドを入力実行するダイアログが

現れます。 
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Tools 

 

＊ ELIBと DLIBは同じ        

フォーマットで、通常の解析において

は実質中身が同じものと考えて問題

ありません。Scaffold DIA上では

ELIB用/DLIB用   オプションは

どちらのフォーマットも利用可能で

す。（例:DLIBの結合に「combine 

ELIB libraries」を使用する、など） 

 

ELIBと DLIBについて 

https://bitbucket.org/searleb/encyclopedia/wiki/ 

EncyclopeDIA%20File%20Formats 

・ Windowing Scheme Wizard – Windowing Scheme Wizard 

(EncyclopeDIAの機能)を起動します。質量分析装置の DIA測定に 

際して装置の設定に必要なウィンドウ幅の設定数値を計算します。 

・ DIA Structure Viewer (mzML only) – DIA Structure Viewer 

(EncyclopeDIAの機能)を起動します。mzMLを開いて windowing 

scheme に関する設定を確認する事ができます。Data Acquisition 

typeの確認などに利用できます。Scaffold DIA 上では mzMLへの

変換ツールを利用できないので、手元の rawファイルを見たい時には

別途msconvert を起動し変換を実施した上でツールに読み込ませる

必要があります。 

・ Launch Peptide Browser – Peptide/DIA Detection Viewer 

(EncyclopeDIAの機能)を起動します。mzMLまたは diaファイル  

から、特定ペプチドを検索します。実行後、ダイアログ内の上のパネル

にはフラグメントイオンのピーク強度が、下のパネルにはスコアの情報

が表示されます（どちらも横軸は RT）。 

・ Convert BLIB to ELIB– BLIBファイルを ELIBファイルに変換しま

す。 

・ Convert MSP/SPTXT to ELIB – MSPや SPTXTを ELIBに変換

します。 

・ Convert Prosit/Spectronaut CSV to DLIB – Prositのライブラ

リ(Prositから出力されたファイル)、または Spectronautのライブラリ

である CSVファイルを DLIBに変換します。出力ファイルは入力ファイ

ルと同じ場所に作成されます。 

・ Convert TraML to ELIB – TraMLファイルを ELIBに変換します。 

・ Convert ELIB to BLIB – ELIBファイルを BLIBに変換します。 

・ Convert ELIB to OpenSWATH TSV – ELIBファイルを

OPENSWATH TSVフォーマットに変換します。出力ファイルは    

入力ファイルと同じ場所に作成されます。 

・ Convert FASTA to Prosit CSV – FASTAファイルから、Prosit 

検索の入力データ(CSV形式)を作成します。作成されたファイルは

Prosit サイトにて入力データとして使用でき、ライブラリを作成する事

ができます。この機能を利用した場合は 以下論文への Citationをつ

けてください。 

https://www.nature.com/articles/s41467-020-15346-1 

・ Combine ELIB libraries – 複数の ELIBファイルを結合します。 

・ Subset ELIB library – ELIBを開き、特定条件に合う結果のみを 

抜き出した新たな ELIBファイルに出力します。 

 

 

 

https://bitbucket.org/searleb/encyclopedia/wiki/EncyclopeDIA%20File%20Formats
https://bitbucket.org/searleb/encyclopedia/wiki/EncyclopeDIA%20File%20Formats
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Help 

 

・ Help on Current View -現在開いている画面/ダイアログの内容に

該当するヘルプ画面を開きます。 

・ Help Contents – ソフトウェアのヘルプを開きます。 

・ Scaffold DIA User’s Guide – Scaffold DIA ユーザーガイド英語

版(PDFファイル)を開きます。 

・ Scaffold DIA FAQs/Resource Center – Proteome Software社

が提供する各種ドキュメントが配置されたWEBページへアクセスしま

す（WEBブラウザ経由）。 

・ Open Demo Files – Scaffold DIA で予め準備している       

デモファイルを開くダイアログが現れます。 

・ Show Log Files – ソフトウェアの実行ログファイルを開きます。   

トラブルシューティングなどで使用します。 

・ Show License Agreement – ライセンス契約内容を表示します。 

・ Referencing Scaffold DIA – Scaffold DIA について論文などに

記載するための記述例を表示します。 

・ Update License Key - ライセンス情報を入力するダイアログが  

現れます。試用ライセンスから製品ライセンスに切り替える場合や、  

期間限定のライセンスを継続する場合などに利用します。 

・ About Scaffold DIA – ライセンス情報や保守期間などが表示され

ます。 

 

 

4-3. ツールバー（アイコン） 

  

画面上部に、頻繁に使うコマンドに対応するアイコンが準備されています（下図）。 

 

 

 

 

 

 

アイコンが表すコマンドは以下の通りです。 

 

アイコン 機能 

 New – 新たなファイルを作成します。詳細は 3章「データの取り込み」をご覧ください。 

 Open – Scaffold DIA のファイル「*.sdia」を開きます。 

 Save – 現在開いているファイルを上書き保存します。 

 Open Library Manager – Library Managerを開きます。 

 Print – 現在開いている画面を印刷します。 

 Print preview - 現在開いている画面を印刷する前に、印刷後のイメージを表示します。 

Fig.4-3 Scaffold DIA ツールバーにあるアイコン 
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 Copy - 現在開いている画面の主な情報をまとめてクリップボードにコピーします。他ソフトウェアに    

テキスト情報として貼り付けることができます。 

 Find - 現在開いている画面内で、キーワード検索をするダイアログを表示します。 

 Quantitative Analysis – 表示されている定量値を元に検定を行ったり、タンパク質の有意基準につい

ての設定を行ったりします（詳しくは「5-7 Experimental Designの設定」(P.43～)をご覧ください）。 

 
Excel - 現在開いている画面に適したレポートを EXCELで読める CSV形式で出力します。 

 
Help - オンラインヘルプを開きます 

 

 

4-4. 表示タンパク質のフィルターリング 

 

 

表示タンパク質について、各種条件によるフィルターリングを行うことができます。 

 

 

 

 

アイコン 機能 

 

Show Hidden – 各種絞り込み条件に合わないタンパク質を表示する / しない を切り

替えます。 

 

Star Filter – Samples画面内にて設定された項目「Star」の内容でフィルターリングを

行います。Starには、/星なし/黄色/青色/黄＋青色/ の 4種類があります。 

 

Name/Accession – キーワード検索により Accessionやタンパク質の名称に対して 

絞り込みを行うことができます。 

 P-value filter - P value が、検定の p値、またはさらに別途定められた Family-Wise 

Error Rate（または FDR）の閾値を超えているかどうかでフィルターリングを行います。

検定を実施した後のみで選択できます。 

 GO term – アサインされた GO 情報によるフィルターリングを行います。 

 Advanced filter - メイン画面にあるフィルター画面では指定しきれないような細かい

条件を指定したフィルターリングを実行します。 

 Protein FDR – Protein FDR の値によるフィルターリングを行います。 

 Min # Peptides - アサインされたペプチド数によるフィルターリングを行います。 

 

 

Fig.4-4 Scaffold DIA 表示タンパク質のフィルターリング設定項目 
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4-5. 各画面への切り替え 

  

 

画面左の「Navigation pane」(Fig.4-5) にて、Scaffold DIA の解析画面を 

切り替えることができます。 

 

 

- Organize  (5章) 

- Samples  (6章) 

- Proteins  (7章) 

- Visualize  (8章) 

- Analysis (9章) 

- Publish  (10章) 

 

 

以降に続く 5章～10章ではそれぞれのパネルについて 

説明しています。 

 

 

 

 

 

 

4-6. FDR 計算値表示 

 

Navigation paneの下に、FDRの情報がまとめられた表示欄があります(Fig.4-6)。ペプチド、タンパク質

それぞれの FDR設定値並びに閾値を超える Target / Decoy エントリーの数が表示されます。 

 

このダッシュボード内の情報は、エディター操作のようにドラッグ＆ドラッグを行ってコピーする事が   

できます。 

 

 

 

 

 

 

 

 

 

Fig.4-5 Scaffold DIA Navigation pane 

Fig.4-6 Scaffold DIA FDR Info ボックス 
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4-7. Summarization  

 

 Summarization バー(Fig.4-7)では、着目するサンプルの階層構造を切り替えることができます。 結果

画面に表示されるサンプル、並びにその定量値も連動して変更されます。 

 

 

 

 

 

 

 

項目の一番下、「Edit」を選ぶと、「Configure Sample Organization and Statistical Analysis」ダイア

ログの「Sample Hierarchy」が表示されます。このダイアログについては「5-6.選択可能な 3種類の

Experimental Designについて(P.41～)」にて詳しく説明しています。 

 

 

  

Fig.4-7 Scaffold DIA Summarization バー 
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5.  Organize画面 

 

5-1. Organize パネルについて 

 

Scaffold DIAではデータの階層につける名称を"Category"と呼び、Category内の各変数（属性）の名称

を"Attribute"と呼びます。Organize パネルではデータの Category(階層)や Attribute(属性)の定義や、   

各 Sampleデータに対して Attribute との紐づけを行う事ができます。 

 例えば、"Treatment Group "という Categoryを定義し、そこに "Control "と "Treated "という

Attribute を配置する事ができます。あるいはタイムコース、薬物の投与に対する反応を測定する研究で

は、"Time "と呼ばれる Category を作成して、そこに属する Attribuiteとして「0min」「20min」

「40min」「60min」などを設定する事もできます。臨床サンプルには多くの場合、年齢、性別、病歴などの

多くの属性が付与されていますが、Scaffold DIA上においても１つのデータに複数の Categoryの

Attributeを割り当てる事が可能です。Categoryと Attributeは、Organize パネルのグラフィカル   

ユーザーインターフェースで定義する事ができるほか、予め設定が完了した情報を内包するファイルを  

読み込んで利用する事ができます。 

 最初に Scaffold DIA にロードされたばかりの段階ではこれらの定義が全くされておらず、取り込んだ

データ(raw又はmzML)の単純なリストが存在するのみです。Fig.5-1 は、サンプルがロードされた直後の

Organize パネル 画面です。 

 

 

 

以降、Organize パネルの画面内で Categoryや Attributeの定義を作成し各データと紐づけをする 

作業についてご案内します。 

 

 

5-2. Organize パネルの画面と設定箇所 

 

Organize パネルの概要です（次頁図）。以下の 4つのポイントに分けてご説明します。 

 

① Category, Attributeの定義設定  [5-3] 

② Sample ファイルと Attribute の関係性を設定・確認する表  [5-4] 

③ Import Attribute File / Export Attribute File  [5-5] 

④ Experimental Designの定義  [5-6,5-7] 

Fig.5-1 データと階層構造の例 

属性情報なし 
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5-3. Category, Attribute の定義設定 

 

画面左側、「Define Categories」では category と、それに属する Attributeの設定を行う事が     

できます(Fig.5-3)。例として、①のエリアで「Treatment」というカテゴリーを作成し、そこに「Control」と

「Insulin」という２つの Attribute を作成する操作をご案内します。 

 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.5-3 Organize 画面 View Table 拡大 

④ Experimental Design の定義 

① Category, Attribute の定義設定 

② Sample ファイルと Attribute の

関係性を確認する表 

Fig.5-2 Organize 画面内の各機能に関する説明 

③ Import Attribute File / Export Attribute File 
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最初に、”Add Category”ボタンを押します（Fig.5-4）。 

 

 

 

 

 

 

 

 

 

 

Category名として「Treatment」と入力します。続いて、右側にある「Add Attribute」をクリックします

（Fig.5-5）。 

 

 

 

 

 

 

 

 

 

 

 

 

Attribute 名として「Insulin」と入力します（Fig.5-6）。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.5-4 Organize 画面 Add Category ボタンの位置 

Fig.5-6 Organize 画面 Attribute 設定 

Fig.5-5 Organize 画面 Add Attribute ボタンの位置 
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必要に応じて色のアイコンをクリックし、色の設定を変更します（Fig.5-7）。 

 

 

 

 

 

 

 

 

 

 

 

 

 

続いて、作成した Attributeの下に新たに現れる「＋Add Attribute」をクリックします（Fig.5-8）。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

同様の操作で、もう１つの Attributeである「Control」を作成します（Fig.5-9）。 

 

 

 

 

 

 

 

 

Fig.5-7 Organize 画面 Attribute の色設定 

Fig.5-8 Organize 画面 Attribute 追加 

Fig.5-9 Organize 画面 Attribute 追加完了 
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以上で作成の操作は終了です。 

もし作成後の Category を削除する時は、画面内のボタン「Delete (カテゴリー名)」をクリックします。  

作成後の Attribute を削除する時は、Attribute を選択してから右クリックして「delete」を選択します。 

 

 

5-4. Sample ファイルと Attribute の関係性を設定・確認する表 

 

Fig.5-2画面、右側の②の領域では、取り込んだ データ の各 Sample と定義した Attribute との   

紐づけの定義をしたりその内容を確認したりする事ができます（Fig.5-10）。 

 

 

 

 

 

 

 

 

 

 

 

以下、データと属性の紐づけ操作に関するご案内です。 

 

[sampleと attributeを紐づけする操作について] 

 

Sampleを選択した状態で右クリックすると、表示リストの中に Category 名が現れます。Category名に

カーソルを合わせると、さらに Attributeが表示されます。Attributeを選択する事で、該当 Sampleに 

選択した Attribute情報が紐づけされます。 

なお Sampleをドラッグ＆ドロップや Ctrlキーを使って複数選択し、同時に Attribute紐づけ設定する事

もできます(Fig.5-11)。 

 

 

 

 

 

 

 

 

 

 

Fig.5-10 Organize 画面 Sample-Attribute 対応表 

Fig.5-11 Organize 画面 Sample に対して Attribute 情報を付与している操作 
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Attribute情報を付与後、その情報が表内に表示されます(Fig.5-12)。 

 

 

 

 

 

 

 

 

 

 

 

[Group Samples By]の選択肢について 

 

３つの選択肢、「Sample Name」「Selected Category」「Experimental Design」があります。 

 

 

 

 

 

 

 

 

 

 

 

表内のデータの並びについてどの項目に着目するかを選びます。 

 

Sample Name: Sample名のアルファベット順に並んだリストになります。 

Selected Category: Category、Attribute名の順に並んだリストになります。 

Experimental Design: Experimental Design(詳細は 5-6.をご参照ください)の階層構造と

Category, Attribute情報に基づきデータがまとめられ表示されます。 

 

 

 

 

 

 

 

 

Fig.5-12 Organize 画面 Sample に Attribute 情報が付与された画面 

Fig.5-13 Organize 画面 「Group Samples By」項目 
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[Bulk Edit Sample Names] と選択肢について 

 

 

 

 

取り込んだ Sample名が長すぎる場合、Scaffold DIAの中でデータを扱いやすくするために、表示  

される Sample名を短く変更すると便利です。一つ一つを選択して表示される Sample名を編集する事も

できますが、データ数が多い時はその操作の実施も非常に煩雑です。そういった場合に一括してファイル名

を変更できるのが、「Bulk Edit Sample Names」ダイアログです (Fig.5-14)。 

ファイル名について、全ファイル名に共通する特定文字を一括して削除したり（Remove prefix, Remove 

suffix*）、ファイル名の前/後ろからの特定文字数を強制的に削除する事ができます(Remove characters 

at beginning, Remove characters at end)。また単純に文字を削除するだけでなく、 選択した

Attribute情報に基づいてファイル名を変更するオプションもあります（Rename based on Attributes）。 

＊prefix -> 接頭語、suffix -> 接尾語 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.5-14 Organize 画面 「Bulk Edit Sample Names」ボタンとダイアログ 
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5-5. Import Attributes File / Export Attributes File 

 

同じデータを取り込むもののパラメータを変えて再検索したい場合、現バージョンの Scaffold DIA で

はデータの読み込みから再度実施する必要があります。その際、Sampleと Attributeの紐づけを再度  

設定するのは少々面倒です。 

そのような時には Sampleファイルと Attribute情報の紐づけ状況をファイルとして保存しておき、後で 

再び読み込んで利用する事ができます。ファイルはカンマで区切られた CSVファイルです(Fig.5-15)。 

 

 

 

 

 

 

 

 

 

 

 

 

設定した内容を CSVファイルとして出力するには”Export Attributes File”を、いったん保存した  

CSVファイルを読み込むには ”Import Attributes File”ボタンを押します (Fig.5-16)。 

 

 

 

 

 

 

 

 

 

 

 

5-6. 選択可能な 3種類の Experimental Designについて 

 

Scaffold DIA では実験計画法に基づいた定量解析を行う事ができます。データの構造について以下３つ

のオプションが選択可能です。 

- Basic Design 

- Repeated Measures 

- Two-way Design 

以降それぞれのオプションについて詳しく説明します。 

Fig.5-16 Import Attribute Files / Export Attributes File 

Fig.5-15 Attributes text file 
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■Basic Design 

 

 

残り 2つの選択肢が特殊な状況を想定しているのに対し、「Basic Design」はより一般的なデータ構造

を想定しており、Experimental Designの選択肢がよくわからない場合はこの「Basic Design」を選択し

て下さい。 

まず比較を行いたい一番大きな分類として、2つ以上の「Biological class」を設定します。「Biological 

class」は実験条件の違いを反映したグループから構成されます（例:Controlと Treatmentなど）。 

それぞれの「Biological class」に「Biological Replicates」を属させる事が可能です。これは同一実験で

ありながらも生物的な差異があるケースなどが当てはまります。さらにそれぞれの「Biological 

Replicates」に対して、繰り返し実験である「Technical Replicates」を対応付ける事ができます。データ 

構造の最下層として、各「Technical Replicates」が複数の画分から構成されている場合それを

「Fraction」として紐づけする事ができます。 

 

Fig.5-17 の状態を Scaffold DIA の Category 情報を使って以下のように定義するとします。 

Group -> { Treatment, Control } 

Subject -> { Subject 1,Subject 2, Subject 3, Subject 4 } 

すると Scaffold DIAの summarization選択では以下のように階層構造が表示されます。 

Group 

Subject 

(MS Sample) 

結果画面の Summarizationで Group を選んだ場合は Treatmentと Control にまとめた結果が、

Subjectを選んだ場合は Subjectの単位でまとめられた結果が表示されます。(MS Sample)を選択した

場合はデータがまとめられず、各MSデータ単位(測定データの単位)で結果が表示されます。 

 

■ Repeated Measures 

同一の生物種個体からデータを取得していることを前提としており、各個人のレベルがどのように変化

するかを分析する際に選ぶ選択肢です。例として、経時的変化を追った実験やクロスオーバー法が挙げら

れます。前述の項目「Basic Design」のように、Biological Replicatesや technical replicates、fraction

などの分類を定義する事もできます。 

Fig.5-17 experimental design 構成例 
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■ Two-way Design 

２つの独立変数の効果を比較し、2つの変数の間に交互作用があるかどうかを判断する際に選ぶ   

選択肢です。例えばある薬剤を投与した時の男性と女性の反応の違いについての比較です。Two-way 

ANOVA を実施すると、３つの尺度で評価する事ができます。３つの尺度とは、2つの要素が交互作用する

程度(Interaction)並びに Primaryとして指定した要素の影響度、並びに Secondaryとして指定した要素

の影響度です。前述の項目「Basic Design」のように、Biological Replicatesや technical replicates、

fractionなどの分類を定義する事もできます。 

 

なお、特殊な状況での Two-way Designである Randomized Block Design (乱塊法)にも対応してい

ます（乱塊法 : Randomized Blocks in Analysis of Variance (ANOVA) - StatsDirect）。サンプルを    

ブロックと呼ばれるグループに分割（ブロック化）し、処理グループの状態以外の既知の要因（年齢・性別等）

と、測定データ側の各要素とが与える影響の度合いを確認します。Randomized Block ANOVA は   

ブロック化したカテゴリーの効果を最小化しながら治療効果 (treatment effect)を見るための解析方法 

です。Two-way ANOVAと異なり、ブロッキング・カテゴリーの効果の評価は行いません。 

 

5-7. Experimental Design の設定 

 

以降、Scaffold DIA 上でデータから実験計画の内容を定義する操作方法についてご紹介します。   

設定は「Configure Sample Organization and Statistical Analysis」ダイアログ(Fig.5-18)から行います。   

ダイアログを表示させる方法は以下の 4通りあります。 

- 「Organize」Viewの画面左下にある「Configure Experimental Design and Statistical 

Analysis」ボタンをクリック 

- menuの「Experiment」-> 「Quantitative analysis」を選択 

- ツールバーにある「Quantitative analysis」アイコンをクリック 

- ツールバーの「Summarization」選択肢内にある「Edit」をクリック 

 Fig.5-18 Configure Sample Organization and Statical Analysis ダイアログ 

https://www.statsdirect.com/help/analysis_of_variance/randomized_blocks.htm
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このダイアログは 2つのタブから構成されています（前頁図赤枠）。 

・「Sample Hierarchy」タブ : 実験の種類の選択や各カテゴリーの位置づけの定義 [5-7-1] 

・「Statistical Analysis」タブ : 検定手法や多重検定の補正についての設定 [5-7-2] 

 

以降、各タブでの設定内容について詳しく説明します。 

 

5-7-1. Sample Hierarchy タブ 

 

４つのパーツから構成されています(Fig.5-19)。 

- Sample Acquisition 

- Experimental Design 

- Summarization Hierarchy 

- Design Matrix 

 

 

Sample Acquisition  

Samples were fractionated 

測定データに分画データが含まれている時にチェックを入れます。定性・定量において分画されたデータ

は解析時に結合して１つのファイルであるかのように取り扱います。チェックを入れると、カテゴリーのどの

分類の属性情報が分画前の属性であるかを指定する設定欄が「Summarization Hierarchy」に現れま

す。 

 

Technical replicates were acquired 

測定データについて、繰り返し実験（同一サンプル・同一条件のサンプルについて測定した）データを含む

時にチェックを入れます。定量において繰り返し実験の単位で標準化を行います。チェックを入れると   

カテゴリーのどの分類の属性情報を使って Technical Replicatesデータを認識するか指定する設定欄が

「Summarization Hierarchy」に現れます。 

Fig.5-19「Simple Hierarchy タブ」の画面上部拡大 
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Experimental Design 

 Basic Design / Repeated Measures / Two-way Design の 3択です。選択肢の詳細は以下の  

通りです。詳細については「5-6.選択可能な 3種類の Experimental Designについて」(P.41～)を   

ご覧ください。 

■ Basic Design 

下記 2手法以外の場合に選択。データを階層構造化し様々な分類でデータを見る事が 

できます。 

■ Repeated Measures 

経時的な変化やクロスオーバー測定など、同一個体種からとったデータの比較をする 

■ Two-way Design 

２つの独立変数の効果を比較し、変数の間に交互作用があるかどうかを判断する 

 

Summarization Hierarchy : 

カテゴリーに対して分類・階層構造化を行う設定欄です。画面上部の「Sample Acquisition」並びに

「Experimental Design」で何を選んだかによって選択肢が変わります。基本的には、画面左側の

「Available Categories」に表示されるカテゴリーを画面右側の分類や階層構造を定める箇所に移動 

（ドラッグ＆ドロップまたは矢印を使用）させて設定します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Available Categories [すべての状況で現れる] 

Organize画面で設定したカテゴリーの一覧です。カテゴリーの設定やデータとの紐づけ方法については   

5-3,5-4 をご覧ください。左側にあるカテゴリーを右側の適切な分類に当てはめていきます。 

 

Categories to be studied [Experimental Designで Basic Designを選択した時] 

統計解析を行う対象となるカテゴリーで、統計解析を行う場合は必ず何かしらのカテゴリーをこの分類に   

アサインする必要があります。ここで指定されるカテゴリーが 1つである場合、そのカテゴリーの属性値毎に  

データがまとめられます。2つ以上指定された場合(Fig.5-20)、各カテゴリーの属性についてすべての        

Fig.5-20 Summarization Hierarchy 設定 / Basic Design 
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組み合わせがデータまとめの対象となります。例えば「Condition」カテゴリーに属性値{Control,Treated} が、

「sex」カテゴリーに{male,female} が存在し Fig5-20のように Conditionと sexどちらも「Categories to be 

studied」に指定していた場合、データまとめの 対象は「Control,male」、「Control,female」、

「Treated,male」、「Treated,female」の 4種類となります。 

 

Biological Samples [すべての状況で現れる] 

「Biological Replicates」にあたる項目を選択する事ができます。 当てはまるものがない場合は特に気にせず

「MS Sample」が選ばれている状態であれば OKです。 

 

Technical Replicates [Sample Acquisitionで Technical replicates were acquiredを選択した時] 

Fig.5-17データの説明における「Technical Replicates」にあたる項目を選択する事ができます。該当する 

ものがなければ「Technical replicates were acquired」のチェックを外してください。該当するものがある  

ものの特に当てはまるカテゴリーがない場合、「MS Sample」が選ばれている状態であれば OKです。 

 

Fractions [Sample Acquisitionで Samples were fractionatedを選択した時] 

Fig.5-17データの説明における「Fractions」にあたる項目を選択する事ができます。該当するものが    

なければ「Samples were fractionated」のチェックを外してください。該当するものがあるものの当てはまる 

カテゴリーが特にない場合、「MS Sample」が選ばれている状態であれば OKです。 

 

[Experimental Designで Repeated Measures Designを選択した時] 

The Time Category  

Repeated Measures Design では同じ解析対象の経時変化や条件を変えたデータ測定を行う実験を想定  

しており、そのようなカテゴリーを選択します。例えば 「TimePoint」カテゴリー{属性値(0hr,1hr,2hr,3hr)}や、

「Treatment」カテゴリーなどです(Fig.5-21)。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.5-21 Summarization Hierarchy 設定 / Repeated Measures Design 
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[Experimental Designで Two-Way Designを選択した時] 

Primary Analysis Category ,Secondary Analysis Category  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Two-way Designは２つの独立変数の効果を比較し、2つの変数の間に交互作用があるかどうかを判断

する際に選ぶ選択肢で、例えばある薬剤を投与した時の男性と女性の反応の違いについての比較などが

例に挙げられます。この時実験の主な焦点となるカテゴリーを Primary Analysis Categoryとして、  

結果に影響を及ぼす可能性があるカテゴリーを Secondary Analysis Categoryで指定します。例では

Primary Analysisカテゴリーに「Treatment」{control,treated}を、Secondary Analysis カテゴリーに

「sex」{male,female}を指定しています。 

 

 

Design Matrix 

設定した Experimental Designの内容に従って、カテゴリーの属性の分類とその属性を持つサンプル

データを確認する事が表形式でまとめられます。 

 

 

 

 

 

Fig.5-22 Summarization Hierarchy 設定 / Two-way Design 

Fig.5-24 Design Matrix 
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5-7-2. Statistical Analysis タブ 

 

検定手法や多重検定の補正についての設定を行います(Fig.5-24)。 

各統計手法や補正に関する詳細は、「11-2.検定(P.85～)」をご覧ください。ここでは設定項目について  

簡単に説明します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Statistical Test 

選択された実験計画の種類や数に基づき、実施/結果表示 可能な検定の選択肢が現れます (Fig.5-

25) 。 

 

 

 

 

 

 

 

 

 

 

Test Hypothesis 

選択された検定に合わせて帰無仮説(H0)と対立仮設(Ha)の内容が表示されます。 

Fig.5-24 Statistical Analysis タブ 

Fig.5-25 Statistical Test 
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Multiple Test Correction 

多重検定の補正、すなわち多重検定に伴う擬陽性の上昇を抑えるために新たに設ける基準についての

設定です。補正方法を選び基準値を指定します。詳細は「11-2.検定」をご覧ください。 

 

Reference Samples 

表示する Intensity情報を Fold Changeとした場合、Referenceとするサンプルをどれにするか指定  

します。さらに対象とする Referenceを、マッチしたデータに対応するサンプルに限定か、カテゴリー内  

全てのサンプルを対象としたものにするかを選ぶことができます。 

 

Design Matrix 

Sample Hierarchyタブでも表示されているのと同様、設定した Experimental Designの内容に  

従って、カテゴリーの属性の分類とその属性を持つサンプルデータを確認する事が表形式で         

まとめられます。こちらのタブではさらに、解析対象とする属性などをチェックボックスで ON/OFFし、 

検定の対象を変更する事も可能です。 

 

 

 

 

 

 

 

 

 

  

Fig.5-26 Design Matrix (Statistical Analysis タブ) 
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6.  Samples画面 

   

 6-1. Samples画面について 

 

 Samples画面では、同定されたタンパク質の一覧並びに定量値をはじめとするタンパク質の関連情報が

表示されます（Fig.6-1）。解析結果を確認する上で主体となる画面です。 

 

 

 

 

この章では Samples画面の表の見方（図[1] Samples Table）と、表示する定量値の内容（図[2] 

DisplayTypeバー）について詳しく説明します。 

 

 

6-2. Samples Table （Fig6-1の[1]） 

 

 Samples Table では、同定タンパク質の一覧並びにそのタンパク質の関連情報、定量値が表示されま

す。 

 Samples Table で表示されるタンパク質は、各種フィルターリング機能で表示対象を変更する事が   

できます。詳しくは 4章「メイン画面」の「4-4.表示タンパク質のフィルターリング」(P.31～)を         

ご覧ください。また各列をクリックする事で降順・昇順に並び替えることができます。 

 

次頁以降で、tableに表示されている各列の内容について説明いたします。 

 

 

Fig.6-1  Scaffold DIA Samples 画面 

Fig6-2. table 左側 Fig6-3. table 右側 

[2] Display type バー 
[1] Sample Table 
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番号 項目 説明 

1 # 上位から順に割り当てた番号 

2 Visible 「Hidden」フィルターにより該当タンパク質をリストに表示するか   

しないかを定めます 

3 Star タンパク質に付与できるマーク。無色/黄色/青/黄色＋青 の 4種類を

設定可能 

4 Protein Name タンパク質の名称 

5 Accession Number タンパク質の ID 

6 Molecular Weight タンパク質の質量 

7 Protein Group 

Score 

Clustering グループに属するタンパク質にアサインされた全ペプチド

の中で最も高いペプチドの同定確率の値。1、すなわち 100%、が   

最大値で数値が大きいほど信頼度の高いペプチドがアサインされて 

いる事を示しています。 

8 Identified Peptide 

Count 

同定ペプチド数 

9 Exclusivity 各タンパク質の全アサインペプチドにおける、Exclusiveペプチドの 

割合。数値が高いほどリスト上の他タンパク質とシェアされている   

ペプチドが少ない事を示し、Exclusivityが 100%のタンパク質は   

すべて他タンパク質とはシェアされていないペプチドだけがアサイン 

された状態である事を示しています。 

10 検定に関する値 検定（Experiment -> Quantitative Analysis）で実施した検定に関連

する数値。p値、q値や変動係数など 

11 Color Legend 項目 14(次頁)の定量値表示の際の凡例。Display typeの切り替えに

より凡例表示も切り替わります。 

 

Fig.6-2 Samples table 左側 

1  2  3 

4 
5 

6 

7 

8 

9 10 
11 
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番号 項目 説明 

12 Taxonomy 生物種 

 13 GO info Gene Ontology 情報 

14 Quantitation 定量値。表示する数値は Display type バーの設定内容に基づきます。また

「Summarization」の選択項目により、データをまとめる単位が変更され、  

定量値を表示する列数が変化します。 

 

 

6-3. Display Type バー （Fig6-1の②） 

 

 

 

 

 

 

 

 

 

 上記 14の定量値について、表示内容を切り替えることができるのが「Display Type」 バーです

(Fig.6-4)。以降、各項目について説明します。 

 

 

 

 

 

Fig.6-3 Samples table 右側 

12 

13

3 

1 2 3 

Fig.6-4 Display Type バー 

4 

14 
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1. Display Type 

表示する数字を以降の 8種類から選択する事ができます。 

 

- Exclusive Intensity   

share ペプチドを除く Exclusive(ユニーク)なペプチドを計算対象としてタンパク質の定量値を  

算出 

- Total Intensity   

share ペプチドも含む全ペプチドを計算対象としてタンパク質の定量値を算出 

 

- Log2 Fold Change (Exclusive Intensity ) 

 share ペプチドを除く Exclusiveな(ユニークな)アサインペプチドを対象としてタンパク質の定量値

を算出し、Referenceとの比を取りその数字に対して 2を底にする Logをとった値。Scaffold    

シリーズでは 比を取り 2を底にする Logを「Fold Change」 として呼んでいます。 

 

Fold Changeを選択した場合、Reference を指定する欄が新たに表れます（下図 Fig.6-5） 

 

 

 

 

 

- Log2 Fold Change (Total Intensity) 

 share ペプチドを含む全アサインペプチドを対象としてタンパク質の定量値を算出し、Referenceと

の比を取りその数字に対して 2を底にする Logをとった値。Fig.6-5 Referenceを指定する欄が  

現れます。 

- CV (Exclusive Intensity) 

share ペプチドを除く Exclusiveな(ユニークな)ペプチドを対象とした定量値の変動係数 

- CV (Total Intensity) 

share ペプチド含むすべてのペプチドを対象とした定量値の変動係数 

- Exclusive Quantified Peptide Count 

share ペプチドを除く Exclusiveな(ユニークな)ペプチドでかつ定量に使われたフラグメントを持つ

ペプチドに限定して数え上げた数に対して、標準化処理を行った数字 (11-1-1, P.84～)。 

- Total Quantified Peptide Count 

share ペプチドを含むペプチドでかつ定量に使われたフラグメントを持つペプチドに限定して数え

上げた数に対して、標準化処理を行った数字(11-1-1, P.84～) 

 

2. Normalized 

Normalizationを実施する/しない を切り替えることができます。サンプルの階層構造定義時に

TR(Technical Replicate) として定義されたグループの単位毎に Normalization の処理が  

行われ、平均の 4分位数と各データの 4分位数の値を揃えるように調整されます。詳細は「11-1-

2. ラベルフリー定量」の「normalization」（P.85～）をご覧ください。 

Fig.6-5  Fold Change を選択した時は reference を選択する項目が現れる 
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3. Log Intensities 

タンパク質の定量値を、底を 10としたログに変換して表示 

 

4. Color Options 

凡例の色分けについて、その境値と色を定義します。ユーザーにより自由に設定変更ができます。 

 

 

 

 

6-4. 「Summarization」と定量値 

 

 データを取り込んだ当初の Samples画面では、各データの定量値がそのまま表示されている状態です

(Fig.6-7)。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.6-6 色分けに関する設定画面 

Fig.6-7 データ取り込み直後の Samples 画面 
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「Organize」画面で各データの階層構造と属性を定義すると、その定義内容が Samples画面にも反映 

されます(Fig.6-8)。表右側の定量値表示で、データ名の上部に階層の属性値が表示されます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Summarization の選択を切り替えて別の階層を選択すると、その階層における属性別にデータが  

まとめ直されます（Fig.6-9）。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 表示の切り替えは Summarization選択と連動して行われます。同じ属性の複数データがどのように  

まとまるかについては、次の項目「6-5.定量値データのまとめられ方」をご覧ください。 

 

Fig.6-8 Organize で階層構造と属性定義後の Samples 画面 

Fig.6-9 Summarization 切り替えを行うと、定量値のデータまとめ方も変わる 
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6-5. 定量値データのまとめられ方 

 

【Rolling up, 代表値はメジアンです】 

Summarizationのレベルを変更し階層構造が上のレベルを選択すると、その階層に属する各定量値 

からメジアンが計算され代表値として表示されます。 

 

 

【不足値と表記】 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Log2 Fold Change あるいは Summarization上位階層選択時の Intensity (または Log10)をまとめ

る(複数サンプルから代表値を計算する)際、値の不足する状況に応じて以下のような表記がされます

(Fig.6-10)。 

 

Missing Value                        --- ratioにおいて参照先（分数の分子）の値がない  

Missing Ref(又は Reference Missing)   --- ratioにおいて参照元（分数の分母）の値がない 

No Values                            --- ratioにおいて参照先も参照元も値がない 

 

Summarizationにより Rolling upする時、50%以上のデータが不足している時には別途計算式によ

って代表値が計算されます(Fig.6-11,緑線)。またすべてMissing Value であった場合は、まとめた時に

もMissing Valueとして表示されます（次頁 Fig.6-11,黒線）。 

 

Fig.6-10 不足値がもたらす特別表記：Missing Value, No Values, Missing Ref 
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Fig.6-11 Rolled up と missing value 
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7. Proteins画面 

 

7-1. Proteins画面について 

 

 Proteins画面ではペプチド/タンパク質の同定並びに定量計算結果をより詳しく検証する事ができます。

タンパク質にアサインされているペプチドの情報、ペプチドが定量計算に使用されているかどうか、    

グループに属するタンパク質のペプチドシェアの状況、等を確認する事ができます。Proteins 画面へ移行

するには、Samples画面で気になるタンパク質が選択されている状態でダブルクリックするか、画面左の

「Proteins」pane(Fig.7-1,緑枠)をクリックします。 

Proteins画面は、２つのタブから構成されています。「Protein」タブと「Similar Proteins」タブです

（Fig.7-1、青枠）。 

Protein タブではペプチド/タンパク質の同定内容やペプチドの定量計算結果を詳しく検証する事ができ

ます。それに対して「Similar Proteins」タブでは、配列が類似するタンパク質を集めたクラスターグループ

に属する、各タンパク質のペプチドシェアの状況を確認する事ができます。 

  

 

 

 

Protein タブは主に４つのパーツから構成されています（Fig.7-1 [1]～[4]）。以降、各パーツで表示   

される内容について説明します。 

 

Fig.7-1 Proteins 画面 「Protein」タブ 

[1] ペプチドフィルターリング 

[2] ペプチド情報 

[3] ペプチド – query 

マッチング情報 

[4] Visualization 
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7-2. ペプチドフィルターリング (Fig.7-1 [1]) 

 

Proteinタブの上部にあるのが「ペプチドフィルターリング」です(Fig.7-2)。 

 

  

 

ペプチド情報（Fig.7-1 [2]）で表示されるペプチドを絞り込む際に利用します。 

Aでグループ内のタンパク質を特定しており、Bでアミノ酸配列あるいは修飾などのキーワードをもとに 

さらにペプチドを絞り込むことができます。絞り込みをリセットする場合は C「Showing All Peptides」  

ボタンをクリックします。この「Showing All peptides」 は Proteins画面内での各種操作により表示  

ペプチドが絞り込み表示になってしまった状態を元に戻す、フィルターリセットをしたい場合に利用します。 

なおペプチドの絞り込みは、[4] Visualizationでタンパク質のカバレージ情報を表示させている際、黄色

のハイライト箇所である同定ペプチド部分をクリックする事でも行われます。 

 

 

7-3. ペプチド情報 (Fig.7-1 [2]) 

 

[2]の「ペプチド情報」欄では、選択したタンパク質あるいはクラスターグループにアサインされ、かつ   

フィルターリング条件を満たしたすべての同定ペプチドが一覧表示されます(Fig.7-3)。 

 

 

 

配列や修飾、ペプチドのタンパク質上の位置、同定確率や質量といった情報が表示されます。必要に  

応じて各列の項目名称で降順や昇順の並び替えを行うことができます。またドラッグ＆ドロップ操作   

などで列の順番を入れ替えたり不要な項目を非表示にすることもできます。 

「Quantified」のチェックの有無は、定量計算に使用される条件（一定数以上のフラグメントの検出など）を

満たしタンパク質の定量計算に当該ペプチドが使用されているかどうかを表しています。 

「Quantified Matches」は、全サンプルに対して定量計算に使用されたサンプルがいくつあるのかを  

表しています。 

 

行の後半に表示される情報はデータの確からしさを評価する指標です（次頁 Fig7-4）。 

Fig.7-2  「Protein」タブ ペプチドフィルターリング 

A  B C 

Fig.7-3  「Protein」タブ ペプチド情報 
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ペプチド情報の欄で表示されている指標は、サンプル全体にまたがって評価した内容です。 

 

「Probability」 : ペプチドの同定確率です。 

 

「Fragment Consistency Score」: 強度値の算出に使用したフラグメントパターンの、サンプル間での

一貫性を表す指標です。同定結果が間違えている、あるいは定量計算への使用に適さない可能性がある 

ペプチドを評価する指標の一つです。「フラグメントのパターンの一貫性」とは Proteins画面右下

の”Chromatograms”→”Fragments”のグラフで表現されている各 Intensity曲線についての、 サンプ

ル間の一致度とも言えます。この指標の計算方法は以下の通りです。 

n個の DIAサンプルからなる実験で検出された各ペプチドについて、そのペプチドに割り当てられた 

各フラグメントの強度を、各サンプルの強度の合計が 1になるよう和で割ります。続いてサンプルと使用 

したフラグメント、値が相対強度の行列を構成します。各セル（M_ij)には、i番目のサンプルにおける     

j番目のフラグメントの調整後の相対強度が含まれます。行列の各列は、サンプル間の単一のフラグメント

の強度を表す「feature ベクトル」とみなす事ができ、各 featureベクトルについて、その平均ベクトルから

のユークリッド距離を算出します。ユークリッド距離の強度加重平均(以下式の avg)を使い、以下の式で

Fragment Consistency Scoreが計算されます。 

(𝑓𝑐𝑠 = (1 − 𝑎𝑣𝑔/√2)
2
 

 

値が 1に近いほどサンプル間の誤差が小さく、サンプル間の相関性がなく独立していると値が 0に近く

なります。サンプルが 2つしかない場合は値の解釈に注意が必要です。 

 

「Peptide Profile Correlation」:各ペプチドのペプチドプロファイルと平均ペプチドプロファイルとの  

ピアソン相関の係数です。Technical replicate単位でピーク強度の和を取りその値を元に標準化処理を

した後、すべてのペプチドから平均値をとった「average profile」を作成してピアソン相関の相関係数を 

求めます。負の値の場合は逆相関があり、また 0に近いと相関性がなく、他のタンパク質とペプチドが共有

されているなどといった要因が影響している可能性が考えられます。  

 

 この表内で選択しているペプチドについて、各サンプルにおける検出状況をまとめたのがすぐ下に表示

される「ペプチド-Queryマッチ情報」（Fig.7-1 [3]）です。またペプチドを選択しダブルクリックすると

Samples画面に戻り、該当ペプチドを含むデータ（タンパク質）のみがリストに表示されます。 

 

Fig.7-4  「Protein」タブ ペプチド情報 
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7-4. ペプチド – Query マッチ情報 (Fig.7-1 [3]) 

 

 

 

 

 

 

 

 

 

 

 すぐ上のペプチド情報テーブルで選択しているペプチドについて、各サンプルにおける検出状況をまとめ

たのが「ペプチド – Query マッチ情報 [3]」です (Fig.7-5)。主な項目について、以下に説明をします。 

「Global Probability」「Global q-value」「Sample Probability」「Sample q-value」 

項目名の最初に「Global」がついている項目は、該当ペプチドがどこかのサンプル 1つ以上に存在する

確率や Percolatorで計算した時の q-valueを表します。ペプチド-Queryマッチ情報の表の中で最も  

確率が高いサンプル 1行にしか表示されません。一方「Sample」で始まる項目は、該当行のサンプルのみ

を対象として求めた Probabilityや q-value が表示されます。 

「Quant. Intensity」 

ペプチドの定量値です。フラグメントピークの XICのピーク面積（定量値）を基に算出されています。 

「# Quant. fragment」 

定量計算に使用したフラグメントの数です。 

「RT Start(min)」「RT Center(min)」「RT Stop(min)」 

該当ペプチドを検出し定量計算に利用した RTの開始・中央・終了の時間を示しています。 

 

7-5. Visualization 情報 (Fig.7-1 [4]) 

 

画面の一番下、Visualization は 7つのタブから構成されています(Fig.7-6)。 

- Protein Sequence 

- Protein Level Charts 

- Statistics 

- Peptide Intensities 

- Fragment Intensities 

- Chromatogram 

- Fragmentation Table 

 

 

 

Fig.7-5  「Protein」タブ ペプチド-Query マッチ情報 左側（上図）と右側（下図） 

Fig.7-6  「Protein」タブ Visualization 情報 
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7-5-1. Protein Sequence タブ 

 

 画面(Fig.7-7)上部にはタンパク質の全配列とマッチしたペプチド領域が、画面下部ではタンパク質全長を

1行で表した状態で、ペプチドのマッチング状況を確認できます。 

 

 

 

 

 画面上部ではタンパク質のアミノ酸配列が表示されます。マッチしたペプチド部分が黄色のハイライトで 

表記、修飾がある部分は色のついた〇で囲まれています。黄色のペプチドをダブルクリックすると画面上の

ペプチド情報欄[2] でフィルターリングがかけられ、該当ペプチドのみが表示されます（この状況を解除  

するためには「Show all peptides」をクリックします）。 

画面下部のカバレージについては、表示の棒状の枠全体がタンパク質全長を表しており、左が N末端

側、右が C末端側です。枠の上には全長に対するペプチド残基長の割合（カバレージ）と、検出された修飾

の総数が表示されています。枠内で黄色のラインで塗られている箇所がペプチドマッチを、黒い線が引かれ

た部分が修飾を表しています。 

右クリックにより、表示されている情報を出力し各種フォーマットのファイルとして保存するメニューが 

現れるほか、配列をコピーしたり BLAST検索にかけたりする事もできます。 

 

 

 

 

[次頁に続きます] 

 

 

 

 

 

 

 

 

Fig.7-7  「Protein」タブ Visualization 情報 Protein Sequence タブ 
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7-5-2. Protein Level Chart タブ 

 

 選択しているペプチドが属するタンパク質について、定量値をグラフ表示します。定量値の表示項目は

Summarizationで選択しているレベルと連動しています。表示形式には箱ひげ図と棒グラフ、       

ヴァイオリン図の 3種類があります(Fig.7-8) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

棒グラフでは、メジアン値並びに誤差範囲が表示されます。 

箱ひげ図では、四分位数並びに最大値と最小値が表示されます。 

ヴァイオリン図は箱ひげ図と似ていますがデータの確率密度の情報も併せて表示されています。 

それぞれグラフにカーソルを合わせると、ポップアップされたダイアログにグラフの主要な数字が表示 

されます。 

 

[次頁に続きます] 

 

 

 

 

Fig.7-8  「Protein」タブ Visualization 情報 Protein Level Chart タブ 
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7-5-3. Statistics タブ 

 

 検定に関する図表です。 

 

Statistics table :  

検定に関連する数字をまとめた表で、実施した検定により表示される数字が異なります。例えば

ANOVA/t-検定の場合、「平方和」「自由度」「平均の平方」「F-統計量」「F-統計量の有意性」です。 

Interaction Chart :  

ユーザーが一次変数と二次変数の間の交互作用効果の解釈を検討するための図です。 

一次変数と二次変数の間に相互作用がない場合、線はほぼ平行になり、線の傾きは一次変数の効果を  

示します。線が平行ではないが交差しない場合、交互作用効果がないとは言えないため、二次変数がある

程度影響を及ぼしている事を理解した上で、一次変数の効果を検討することになります。線が交差する  

場合 2つの変数が有意な相互作用を示すことを意味し，一次変数の効果について一般的な結論を出す  

ことは不可能と言えます。 

 

7-5-4. Protein Intensities タブ 

 

 

Peptide Intensities タブには、Fig.7-9のようにタンパク質にアサインされた各ペプチドの定量値を   

積み重ねた棒グラフが表示されます。タンパク質の定量値計算に使用された各ペプチドの全強度に対する

割合を表しており、各ペプチドの影響度（寄与の度合い）がわかります。 

データをまとめる単位は選択中のカテゴリーに連動します。またサンプル横断的にデータを見ながら  

組成の変わっている箇所に注目する事で、各ペプチドの定量評価における信頼度を検討する事も     

できます。例えばカテゴリー間で大きく割合が変動しているようであれば、該当ペプチドを信頼度の低い 

ものとして除外する事を検討する必要があります。なお検証の結果もし除外を行いたい場合、ペプチド  

情報欄の Quantifiedチェックボックスをオフにしてください。 

図のバンドにマウスを合わせると、ペプチドの強度値も含むペプチドの情報が表示されます。さらに   

クリックするとペプチドのフィルターリングが行われます。（フィルターリングを解除するには、タブ上部の 

Show All Peptides をクリックしてください）。 

ペプチドを識別するための凡例表示切替オプションも準備されており、表示数が多い扱いにくい場合は

表示をオフにしてください。 

Fig.7-9  「Protein」タブ Visualization 情報 Peptide Intensities タブ 
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7-5-5. Fragment Intensities タブ 

 

「Fragment Intensities」タブでは、選択ペプチドについて定量計算に利用したフラグメントピークの  

定量値の割合が表示されます(Fig.7-10)。ペプチドの定量データの信頼度を評価する際等に利用できま

す。検証の結果もし除外を行いたい場合、ペプチド  情報欄の Quantifiedチェックボックスをオフにして

ください。 

 

 

 

 

7-5-6. Chromatograms タブ 

 

 Precursor, Fragment それぞれにおける XIC、保持時間別の強度値です（Fig7-11）。 

 

 

左が Precursor、右が Fragment の図で、共に横軸は保持時間、縦軸が Intensityです。グラフ内で 

青くなっている領域が定量計算に使用された時間帯です。左の Precursor図では、+1,+2 の        

アイソトピックについても併せて表示されています。右の Fragmentsの図では定量計算に使用された   

フラグメントについて表示されています。検出されているものの定量計算には利用されていない      

Fig.7-11  「Protein」タブ Visualization 情報 Chromatgram タブ 

Fig.7-10  「Protein」タブ Visualization 情報 Fragment Intensities タブ 
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フラグメントについては色のない点線で表示されています。Precursor, Fragments どちらの図に    

おいても、グラフ内の線にカーソルを合わせるとその線と凡例が強調表示されどの項目かわかります。  

またドラッグ＆ドロップの操作でグラフを拡大表示する事が可能であるほか、右クリックで表示を微調整 

したり、画像やデータを保存したりする事も出来ます(次頁 Fig.7-12)。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

7-5-7. Fragmentation table タブ 

 

 ペプチドの配列から計算されるフラグメントの m/z理論値一覧の表です。さらに検出された       

フラグメントを色分け表示しています (Fig.7-13)。 

 

 

 

 

 

Fig.7-13  「Protein」タブ Visualization 情報 Fragment table タブ 

Fig.7-12  Chromatgram タブ グラフ拡大 
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7-6. Similar Proteins タブ 

 

Similar Proteins タブでは、マッチしたペプチドの重なり具合を見てリスト内の同定タンパク質間の   

類似度を確認する事ができます。類似タンパク質の候補として、protein inference にて良く使用される 

概念の話で使用される用語でいえば same protein, sub-set protein,並びに family protein に    

該当するタンパク質が表内に現れます。ユニークなペプチド(「Exclusive to」の列に色をつけて表示)や  

シェアされたペプチドがどれなのかをわかりやすく図示しています(Fig.7-14)。シェアペプチドは、その  

シェアされているタンパク質の数により円マークの色塗り部分が 1/2, 1/3, 1/4 … と変わります。 

 

 

  

Fig.7-14  「Similar Proteins」タブ 
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8. Visualize 画面 

 

8-1. Visualize 画面について 

 

 

 

 

 Visualize 画面では、主に定量的なデータの傾向をつかむのに役立つグラフを提供しています。

Visualize画面には、「Quantitation」タブと「Principal Component Analysis」タブ、そして

「Heatmap」タブの 3つが存在します(Fig.8-1赤丸部分)。 

 

以降、それぞれのタブ内にある図について説明します。 

 

 

 

 

 

 

Fig.8-1  Visualize 画面 
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8-2. Quantitation タブ 

 

Quantitationタブは４つのパーツから構成されます (Fig.8-2)。 

 

 

 

① Volcano plot (8-2-1, P.70) 

② Quantitative Scatterplot (8-2-2, P.71) 

③ Quantitative Trend Chart, Quantitative CVs (8-2-3, P.72) 

④ GO Term Pie Chart, GO Connections Graph (8-2-4, P.73) 

 

以降、それぞれのグラフについて説明します。 

 

 

 

 

 

 

 

Fig.8-2  Visualize 画面 Quantitation タブ 

① Volcano plot 

② Quantitative  

Scatterplot 

③ Quantitative 

 Trend Chart & CVs 

④ GO info 
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8-2-1. Protein Sequence  

 

Volcano plot は 2つのグループを比較する検定を行った時のみ表示されます（Fig.8-3）。x 軸は

Fold Change（ratio,かつ Log2変換）、 y軸は検定時に計算された p-value の Log10 にマイナスを   

掛けた値です。プロット １つ１つはタンパク質の定量データに対応しています。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

縦軸の値が上に行けば行くほど p-valueが低く統計的に有意な差がある事を表し、また横軸については

0から離れるほどサンプル間で発現量に差がある事になります。 

プロットの色にも意味があります。Scaffold DIA内で定めた「Significant Level」、例えば FDRや

FWERの閾値を超える条件を持つデータは緑、その基準未満で p ≦ 0.05 のデータは黄色で表示   

されます。この色分けは、Samples画面の統計数値（p-value）表示列にも同じ条件が適用されています。 

グラフの左側にはいくつかのオプションがあります。縦軸では補正後の有意なラインをグラフ内に表示 

したり、横軸では比較サンプルの定量値が同じ（値が 0になるライン）を表示したりする事ができます。  

また「Multiselect Action」の項目には星を付けるオプションがあり、グラフ内で左クリックによる四角形 

ドラッグ描写を行うと、その四角形に含まれるタンパク質に星印がつきます（Samples画面で確認     

できます）。 

 

Fig.8-3  Visualize 画面 Quantitation タブ Volcano plot 
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8-2-2. Quantitative Scatterplot 

 

「Quantitative Scatterplot」では選択した２つの要素の定量値をプロットした散布図が表示されます

(Fig.8-4)。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

グラフ左の設定で、x,y両軸に置くサンプル/選択項目を変更したり、 y=x の直線や回帰直線も表示  

させることができます。また「Multiselect Action」の項目には星を付けるオプションがあり、グラフ内で 

左クリックによる四角形ドラッグ描写を行うと、その四角形に含まれるタンパク質に星印がつきます

（Samples画面で確認できます）。 

 

 

 

Fig.8-4  Visualize 画面 Quantitation タブ Scatterplot 
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8-2-3. Quantitative Trend Chart & CVs 

 

 Visualize画面の左下には 3つのタブ「Quantitative Trend Chart」、            

「Pre/Post Normalization」、そして「Quantitative CVs」の図が存在します。 

  

「Quantitative Trend Chart」では、フィルター適用後のタンパク質すべてを対象に、定量値の分布に

関する情報を様々なグラフ（箱ひげ図・棒グラフ・Trend Line・ヴァイオリン図）で表示しています。 

「Pre/Post Normalization」タブでは、Normalization 前後の定量値について、箱ひげ図または   

ヴァイオリン図で比較する事ができます(Fig.8-5)。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

「Quantitative CVs」には定量値の信頼性を評価する２つのグラフが同時に表示されています  

(Fig.8-6)。グラフは Samplesで選択されている Summary単位による区分が適用されます。2種類の 

表示のうち１つは CV50%の信頼区間ならびにその中央値の線です。以下図の場合、線と色分け区間で  

表現されているグラフの方になります。もう１つはカーネル密度推定値を使った分布となります。 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.8-５  Visualize 画面 Quantitation タブ Quantitative Trend Chart 

Fig.8-6  Visualize 画面 Quantitation タブ Quantitative CVs  
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8-2-4. GO Term Pie Chart, GO Connections Graph 

 

GO情報に関しては２つのタブから構成されています。「GO Term Pie Chart」と「GO Connections 

Graph」です。利用するためにはデータ取り込み後に「GO情報の付与」（メニューの experiment -> Apply 

GO Terms）を実行する必要があります。GO情報について詳細は本資料の 15章（P.108～）を      

ご覧ください。 

 

GO Term Pie Chart は、付与された Gene Ontology 情報を数え上げ円グラフにしたもの(Fig.8-7) 

で、Biological Process, Cellular Component, Molecular Function それぞれの分類で描写させる  

ことができます。グラフの右上にグラフ描写に関するいくつかのオプションがあります。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

「GO Connections Graph」は、 GOの項目とタンパク質を線で繋いだもので、GOで共通項の多い 

タンパク質を可視化する図です(Fig.8-8)。色のついた項目が GOの項目で、白い項目がタンパク質です。 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.8-8  Visualize 画面 Quantitation タブ GO Connections Graph 

Fig.8-7  Visualize 画面 Quantitation タブ GO Term Pie Chart 
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8-3. Principal Component Analysis タブ 

 

PCA解析[主成分分析]とは、データのばらつきに影響を及ぼす「主成分」を見つけ、データの特徴を抽出

する解析手法です。PCA解析の詳細については、英文マニュアルの「Appendix I. How PCA is 

Performed in Scaffold DIA(P.195～)」 をご覧ください。 

 

Principal Component Analysis タブは４つのパネルから構成されています（Fig.8-9）。 

 

 

 

 

 

- Overview (左上,8-3-1)   

- Scree Plot (右上,8-3-2) 

- Scores Plot (左下,8-3-3) 

- Loadings Plot (右下,8-3-4) 

 

です。次頁以降、各グラフについて詳しく説明します。 

 

 

 

 

 

 

 

 

 

Fig.8-9  Visualize 画面 Principal Component Analysis タブ 

Overview 
Scree Plot 

Scores Plot Loadings Plot 
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8-3-1. Overview 

 

主成分間における値のプロットです(Fig.8-10)。グラフ内の点はサンプルを表しています。グラフを選択

した状態でプロットにカーソルを合わせると、主成分の組み合わせについて確認する事ができます。また

選択中のグラフに対応して左下の Scores Plotや右下の「Loadings Plot」が連動して表示変更       

されます。右下の「Fewer Principal Components」「More Principal Components」ボタンを押す事で、  

解析対象の主成分数を増減する事ができます。 

 

 

 

 

8-3-2. Scree Plot 

 

 赤い線が各主成分の寄与率、青い線が寄与率の累積を表します（Fig.8-11）。 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.8-10  Visualize 画面 Principal Component Analysis タブ Overview 

PC1 が y軸 

PC1 が 

x軸 

寄与率 

Fig.8-11  Visualize 画面 Principal Component Analysis タブ Scree Plot 
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8-3-3. Scores Plot 

 

Overview で選択したグラフを拡大した、主成分間のスコア分布図です(Fig.8-12)。色のついた楕円は

該当エリア内に同じ属性値を持ったデータが入るとみなした時の N%信頼区間で、Nの数字はグラフ左の

オプション(Confidence)で変更することができます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

8-3-4. Loading Plot 

 

 各タンパク質の主成分への寄与を表す分布図(Fig.8-13)で、絶対値が大きいほどその主成分への影響が

大きいことを示しています。原点から離れているタンパク質に注目してください。「Multiselect Action」で

気になるタンパク質に星印をつけ、Samples画面で確認する事もできます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.8-12 Visualize 画面 Principal Component Analysis タブ Scores Plot 

Fig.8-13 Visualize 画面 Principal Component Analysis タブ Loadings Plot 
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8-4. Heatmap タブ 

 

ヒートマップは 2次元の表や行列で構成された複雑なデータセットを可視化する有力な方法のひとつ 

です。類似性の高いデータを近さの基準に従って空間的にまとめつつ行と列を並び替えると同時に、   

各セルにあたる定量値について量の大小を表す色分けをして傾向をわかりやすくしています。 

ヒートマップはデータ数が多すぎると意味が薄れるため、Scaffold DIAではタンパク質数の上限を

1000に定めています。そのため 1000を超えているケースでヒートマップを適用したい場合、ユーザーが

事前に Samples画面でデータ数を制限して 1000未満にする必要があります。制限をする際には    

キーワード検索や GO並び替えで項目をピックアップするとともに、それらに対して星印を付して絞り込み

表示に活用してください。（→P.51） 

ヒートマップタブは 2つの画面から構成されます。 

- Heatmap Landscape   : ヒートマップの全体図 (8-4-1) 

- Heatmap Details pane : ヒートマップのうち全体図で選択した内容についてのみ、より詳しい 

情報を表示した図 (8-4-2) 

２つの画面のうちそれぞれ一方のみ、あるいは両方を表示するかどうかで３つの選択肢（ラジオボタン）が

あります(Fig.8-14)。 

 

 

 

 

8-4-1. Heatmap Landscape pane 

 

行がタンパク質、列がサンプルに該当します。行・列ともに Samples画面で選択した内容が反映されて

います。行列どちらもクラスタリングの結果を表すデンドログラムが記載され、その結果を基にデータが 

並び直されています。デンドログラム内のブロックをクリックするとその塊が選択されます。選択状態にあ

る領域は灰色で表示されます。ブロックの内容について詳しい情報は、「Heatmap Details pane」にて  

確認できるほか、ブロックの内部における相同性が表示されます(Fig.8-14)。 

Fig.8-14 Visualize 画面 Heatmap タブ 
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ヒートマップのデータの内容を数字の CSV出力したい時、あるいはグラフを図として出力したい時、  

画面内で右クリックしてそれぞれの操作を実行できます(Fig.8-15)。 

 

 

 

 

 

 

 

 

 

 

 

 

 

8-4-2. Heatmap Details pane 

Landscapeで選択されたブロックについて、タンパク質の名称や Descriptionなども含めたより詳しい 

情報を確認する事ができます(Fig.8-16)。 

 

 

 

 

Fig.8-15 Visualize 画面 Heatmap タブ、コンテキスト 

Fig.8-16 Visualize 画面 Heatmap タブ、details info. 
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9. Analysis 画面 

 

9-1. Analysis画面のグラフについて 

 

Analysis 画面では TICと補正前後の LC保持時間の誤差を確認する事ができます（Fig.9-1）。２つの

グラフを上下並べて表示しています。横軸は共に(Reference) Retention Time (min) です。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

上のグラフは、縦軸が TIC(Total Ion Current)です。TICはMS1/ペプチドレベルのデータから計算  

しています。x軸である保持時間についてはアライメントの前と後、どちらでも表示可能です。グラフ上に 

あるチェックボックスにより表示の切り替えができます。 

 

下のグラフは元データの RTとアライメント後の値との誤差（元データとリファレンスの差）を表して   

います。 

 

どちらも凡例ならびに実線の上にカーソルを合わせると強調表示され、凡例との連動によりどのデータ

がどの曲線か、わかりやすくなります。 

 

 

  

Fig.9-1 Analysis 画面  
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10. Publish 画面 

 

10-1. Publish 画面について 

 

Publish画面は、検索パラメータ一覧を確認したり、論文や Repository siteで記載するMethodの 

文章にまとめた内容を表示したりする「Experiment Methods」タブと、SQLコマンドを実施して    

テーブル（ファイル）を出力する「SQL Report」タブから構成されています(Fig.10-1)。 

 

 

 

 

以降、Experiment Method タブ (10-2)、SQL Report タブ (10-3) についてご紹介します。 

 

 

 

 

 

Fig.10-1 Publish 画面  
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10-2. Experiment Methods タブ 

 

 Experiment Methods タブでは表示内容が大きく右側と左側に分かれています。 

左側は Scaffold DIA で指定したパラメータが、ツリー上にまとめられて表示されています    

（Fig.10-2）。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.10-2  Experimental Method 左側 
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一方右側には、論文やレポートのMethod 部分を意識した、解析手法についてまとめられた文章が表示

されます (Fig.10-3)。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

これらの文章は、クリップボードにテキストとして保存させたり、CSV形式でデータを出力させたりする

ことができます。 

Fig.10-3  Experimental Method 右側 
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10-3. SQL Report タブ 

 

Scaffold DIAから、オープンソースのリレーショナルデータベース管理システム：SQLiteのファイルを 

出力する事ができます。SQL Reportタブでは SQLiteの GUIが使用可能です。ユーザーは SQLiteの 

コマンドを実行する事で、データを好きなように集め、出力する事ができます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

出力される実験ファイル、sdia(sfdb)のスキーマについては、英文マニュアルの「Appendix A. 

Structure of Scaffold DIA files」（P.172～）をご覧ください。 

 

 

 

  

Fig.10-4  SQL Report タブ 
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11.定量の手法と検定機能 

 

 Scaffold DIAではフラグメントピークの強度情報を基にしたラベルフリーの定量解析をサポートして   

います。値はサンプル間で Normalizationする事ができ、因子レベルや治療法の組み合わせによる発現の

違いを確認するため、様々な検定を適用する事ができます。なお基本的に Normalizationは実験間の  

比較レベルにおいてタンパク質総量が同じである前提の下で行われており、総量が異なるケースにおいて

Normalizationを行う事は適切ではありません。 

 

 

11-1. 定量の手法について 

 

11-1-1. Peptide Counting 

 

Scaffold DIA では定量解析の一環として、以下の２つのペプチド数を Samples画面で表示可能です。

Display typeを通じて表示内容を選択する事ができます。  

 ・Total Quantified Peptide Count 

   EncyclopeDIA によって同定され定量に使われているペプチドについて、シェアペプチドかどうかに 

関わらずタンパク質毎にカウントした数字です。 

 ・Exclusive Quantified Peptide Count 

   EncyclopeDIA によって同定され定量に使われているペプチドについて、シェアペプチドを除きユニーク

ペプチドのみをカウントした数字です。 

 

 もう１つ重要な点として、これらの表示におけるペプチドカウント数は正規化されているのでご注意   

ください。Samplesテーブルに表示される値を調整し、各列のユニークペプチドの合計数が同じになる  

ようにします。選択したまとめのレベルに応じ、Samplesテーブルで表示される列の数は変動し、カウント

も変動します。 

 

11-1-2. ラベルフリー定量 

 

■ ペプチドの定量、タンパク質の定量 

Scaffold DIA では XICにおけるフラグメントイオンのピーク強度をベースとしたラベルフリー定量を 

採用しています。プリカーサーイオンのピーク強度は定量計算そのものには利用されていません。 

Scaffold DIA では定量の対象とするフラグメントの選定において、他のフラグメントイオンの干渉の 

影響ができるだけないきれいなピークを選ぶため、干渉度合いを表すスコアによって評価しています。  

選ばれたフラグメントピークについて、バックグラウンドの影響も加味して差し引いた面積強度を算出し、

その和がペプチドの定量値となります。場合によっては、検索したスペクトルライブラリのピークとしては含

まれていないフラグメントが定量されることがあります。これは、EncyclopeDIAがペプチドの理論的な          

フラグメンテーションパターンも考慮しており、理論的なスペクトルから追加のフラグメントイオンが同定 

された場合、それらを選択して定量計算に加える事が可能である、という事です。 
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選択されたペプチドについては、全サンプルで見た干渉の程度や、ユーザーが指定したパラメータに合致

するかを判定したスコアを元に取捨選択され、タンパク質の定量値計算に利用されます。 

 

■ Normalization 

Normalizationはユーザーが Experimental Design ダイアログで指定した Technical Replicates 

レベルで行われます（設定前は全データを１つのグループとして見ています）。 

まず intensityの和が Log10に変換され、Experimental Designで TR [Technical Replicate] の 

グループと認定されたデータ間で、各サンプルの四分位数における数字が全体平均の四分位数における 

数字と一致するように調整され、四分位数間は直線で近似します。調整後、Log10から通常の数字に戻し、

TRレベルで和を計算して結果画面に表示されます。 

 Normalizationは画面にあるチェックボタンで実施する/しない を切り替える事ができます。 

 

■ 欠損値  

 

欠損値は Scaffold DIAの様々な計算に影響を与えるため、適切な処理をする必要があります。値を  

より高いレベルで要約したり、統計的なテストや主成分分析を行ったりするため、測定値が得られなかった

場合に適切な値を入力する必要があります。 

DIA分析における欠損値はサンプル中にペプチドが存在しないか、または非常に低い強度で存在するか

のいずれかの結果であると仮定し、Scaffold DIAでは「Quantile Regression for Imputation of Left-

Censored data法*」（QRILC）を使用した値の代入を行っています。 

* Cosmin Lazar (2015): imputeLCMD v2.0". R package version 2.0 

QRILCは，観測値（非欠損値）と欠損値および観測値の数をもとに想定した正規分布から，欠損値が  

どの観測値よりも小さいと仮定して値を推定します。 

また欠損率が 50％を超えるケースでデータをまとめる場合、QRILCで推定した平均値を使用します。 

なおその場合部分的に欠損しているものとして扱い、値を括弧で囲んで表示します。 

欠損値の割合が全体データ数に対して X%の場合、推定値は推定分布の Xパーセンタイル以下になる 

ようにします。 

QRILCの参照実装を提供する Rパッケージ "imputeLCMD v2.0 "もありますので、そちらの文章も  

併せてご参照ください。 

（https://www.rdocumentation.org/packages/imputeLCMD/versions/2.0/topics/impute.QRI

LC）． 

 また英文マニュアルの「 Appendix.D Missing Value」(P.178～)にも説明がございます。 

 

 

 

[次頁に続きます] 

 

 

 

 

https://www.rdocumentation.org/packages/imputeLCMD/versions/2.0/topics/impute.QRILC
https://www.rdocumentation.org/packages/imputeLCMD/versions/2.0/topics/impute.QRILC
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11-2. 検定 

 

Scaffold DIAではいくつかの検定機能を有しています。検定機能を実行するためには、Experimental 

Design の設定が必要となります。検定ならびに Experimental Designの設定は、 

「Configure Sample Organization and Statistical Analysis」ダイアログにて行います。この    

ダイアログを表示させるには以下 4通りの操作があります。 

 

- 「Organize」Viewの画面左下にある「Configure Experimental Design and Statistical 

Analysis」ボタンをクリック 

- menuの「Experiment」-> 「Quantitative analysis」を選択 

- ツールバーにある「Quantitative analysis」アイコンをクリック 

- ツールバーの「Summarization」選択肢内にある「Edit」をクリック 

 

選択時に開くダイアログは、「Sample Hierarchy」と「Statistical Analysis」２つのタブで構成されて

います。 

Experimental Designで選択可能な項目の内容については「5-6. 選択可能な 3種類の

Experimental Designについて(P.41～)」を、選択内容の設定については「5-7. Experimental 

Design の設定(P.44～)」をご覧ください。 

  

 検定を実行すると、Samples欄に検定に関する数字を表示する列が現れます。選択した検定によって  

表示される数字は異なります（p-valueや q-valueなど）。セルは、有意で設定した Error rateを超えて 

いる場合は緑色で、また有意だが Error rateの設定を超えていない場合は黄色に色塗りされ、一方     

有意でない場合は無色となります。 

 

以下に、各データ構成タイプで選択可能な検定についてその内容を説明します。主な観点は「サンプル数」

と「パラメトリック/ノンパラメトリック」となります。 

 

 

11-2-1. Basic Designで実施可能な検定 

 

・ t-test / ANOVA 

  取り扱うグループまたはカテゴリー間の平均値の等質性を評価する検定で、カテゴリー間に差があるか

どうかを示します。両側検定を行います。3群以上が ANOVAで、解析対象が 2群しかない場合 t検定と

なります。 

 

・ Permutation Test 

 2群あるいは 3群以上のグループ比較で有意な差があるかを検定できる手法です。ベースは F検定 

ですが、群間のランダムなデータを入れ替えて F値を計算し続けます。Scaffold DIAでは 10000回の  

計算を行い、入れ替えた際に入れ替える前の F値を超えた回数を 10000（試行回数）で割った値を    

p-value とします。 
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・ Mann-Whitney U Test 

 独立した観測値の２つの標本のうち、一方の値が他方の値よりも大きい傾向にあるかどうかを評価する

ノンパラメトリック検定です。２つの中央値が等しいかどうかに依存せず、２つの標本データの順位を使用 

します。比較サンプル数がきっちり２つでないと使用できません。 

 

・ Kruskal-Wallis Test 

順位別一元配置分散分析とも言え、標本が同じ分布に由来するかどうかを検定するノンパラメトリックな

手法です。しかし同じ分布の形とスケールである事を前提としています（中央値が同じである事を求めてい

ません）。独立した 3つ以上のサンプルに適用可能です。帰無仮説は「サンプルが由来する集団が同じ   

中央値を持つ」であり、検定が有意な時、少なくとも 1つのサンプルが他のサンプルとは異なる事を意味 

します。この検定は差がどこで発生したのか、どれだけの差が発生したのかを特定する事はできません。  

 

 

11-2-2. Repeated Measuresで実施可能な検定 

 

・ Repeated Measures ANOVA/Paired t-test 

反復測定分散分析(rANOVA)はパラメトリックな手法です。3つ以上の条件の違い（経時変化など）を  

考慮した繰り返し測定が行われている場合、それらの測定の母平均が異なるかどうかを評価しています。 

 Paired- t検定も同様ですがこちらはサンプルが２つの時にとられる手法です。正規分布でカテゴリー間

の分散が等しい場合に適用可能です。 

 

・ Wilcoxon Signed-rank test 

 ノンパラメトリックな手法でサンプル数は 2つの時に限定されます。繰り返し測定の母平均の順位が  

異なるかどうかを評価しており、２つのサンプルが独立で同一の分布であることを前提としています。  

パラメトリックな手法である Paired t-test が適用できない際にご利用を検討してください。 

 

・ Friedman test 

ノンパラメトリックな手法で 3つ以上のサンプルがある時に適用する手法で、母平均順位が異なるか  

どうかを評価しています。サンプルが独立で同一の分布であることを前提としています。パラメトリックな

手法である rANOVAの代替方法であり、分析データが正規分布でない場合に適用してください。 

 

 

11-2-3. Two-wayで実施可能な検定 

 

・ Two-way ANOVA 

二元配置分散分析では２つの独立変数がタンパク質の量に与える影響を評価します。それぞれの独立 

変数の主効果を測定し、さらに変数間に有意な相互作用があるかどうかも判定します。 
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・ Randomized Block ANOVA 

Secondary分析カテゴリー（この場合はブロック因子）の効果をコントロールしながら、Primary分析 

カテゴリーの効果を評価します。Secondary分析カテゴリーそのものの効果を評価するものでは     

ありませんが、ブロッキング効果を評価するオプションとして、Primary 分析カテゴリーと Secondary  

分析カテゴリーとの間に有意な相互作用があるかどうかを評価する事ができます。 

 

・ Friedman test 

ノンパラメトリックな手法で 3つ以上の条件で測定が行われた時、母平均順位が異なるかどうかを評価

しています。サンプルが独立で同一の分布であることを前提としています。分析データが正規分布でない 

場合に適用してください。 

 

 

11-3. 多重検定補正 

 

多重検定において第一種の過誤（帰無仮説が真であるにもかかわらず偽として棄却してしまう誤り）を 

防ぐため、p値と調整し直す処理を施す事があります。シンプルな方法としては Bonferroni補正という 

手法があります。これは pを検定数 Nで割った p/N を新たな基準として使う方法ですが、この基準では

厳しすぎて False Negative が増えすぎてしまうのが問題です。Scaffold DIAではその点を考慮した２つ

の補正方法を採用しています。 

 

- ホッホベルクのステップアップ手順＆ホルムのステップダウン (FWER) 

- BH法 (FDR) 

 

■ FWERとホッホベルクのステップアップ＆ホルムのステップダウン 

Bonferroniの不等式をベースとした、単純な Bonferroni補正より積極的に同定タンパク質を拾える 

補正を行って Family-wise error rate (FWER)をコントロールする手法です。「ホッホベルクのステップア

ップ」と「ホルムのステップダウン」の２つをサポートしています。 

詳細については 英文マニュアルの 「Appendix G. Controlling the Family-wise Error Rate」

（P.184～）をご覧ください。 

 

■ FDRと BH法 

Scaffold DIA では FDR (False Discovery Rate)の計算を、Benjamini-Hochberg 法で計算して  

います。FDRペプチドやタンパク質で使用している FDRとは基本コンセプトが同じあるものの中身は  

大きく異なりますのでご注意ください。 
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12. タンパク質のグループ化、クラスター化 

 

12-1. 同定タンパク質のグループ化、クラスター化 

 

Scaffold DIAで表示される同定タンパク質は、シェアペプチドの情報を基に類似タンパク質がグループ

化、クラスター化されます。クラスター化における基準について、menuの experiment -> Protein 

Clustering-> Shared Evidence clustering を選択する事によって現れるダイアログで変更可能です

(Fig.12-1)。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

類似度合いの評価については、二つのタンパク質 A,B のペプチドシェア度合いを表す L(A,B)と、閾値の

λによって定義されています。詳細は英語マニュアルApendix .Shared Evidence Clustering Algorithm 

(P.180～)をご覧ください。パラメーターL (A,B)は、以下のように計算されています。 

 

 

 

 

 

Fig.12-1  Cluster Proteins with Shared Evience ダイアログ 
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L(A,B) をλと比較して基準を満たす時、タンパク質がクラスター化されます。 

ダイアログ内各項目の選択肢とλはそれぞれ次頁の通りです。 

 

Perfect shared evidence protein groups 

λ= 1 、すなわち L(A,B)=1で Aと Bが same-set でないとグループ化されません。最低限の設定レベル

として常にオンになっているため、グレイアウトして設定が変更できないようになっています。 

 

Moderate shared evidence clusters 

λ= 1/3 を基準として L(A,B)が 1/3 以上の時グループ化されます。「Perfect shared evidence protein 

groups」と「Any shared evidence clusters」の項目の間に定められた設定です。 

 

Any shared evidence clusters 

λ= 0 を基準値としており、L(A,B)が 0より大きい時、すなわち１つでもシェアペプチドがあればクラスター

化されます。MASCOTなどで採用されている基準と同等です。 

 

なお、「Moderate shared evidence clusters」と「Any shared evidence clusters」の両方にチェックが

入った状態の場合、サブクラスターが表示されます。大きなクラスターは Moderate shared evidence 

clustersの基準が、その中のサブクラスターは Any shared evidence clustersの基準が適用されます。 
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13. Report 

 

13-1. Scaffold DIA で出力可能なファイルについて 

 

Scaffold DIA では様々な内容のファイル出力が可能です。メニューバーの「Export」にまとめられて  

います。 

 

・ Export Attributes File 

サンプルデータの属性設定値である Attribute設定、並びに rawデータと attributeとの関連を 

記した Scaffold DIA用のフォーマットのテキストファイルを出力します。Organize画面の「Export 

Attributes File…」ボタンと同じです。出力したファイルは Organize画面で再び取り込む事が   

できます。同じデータで異なる条件を適用する  再検索などに利用します。 

 

・ Export Samples Report to Excel 

     Samples 画面で表示される内容、タンパク質の定量値のレポートを CSV 形式（コンマ区切りの   

テキストファイル）で出力できます。出力前には Fig.13-1 のような Export する定量値を選択する  

ダイアログが現れます。Samples 画面では一つしか表示されない定量値ですが、出力時には複数選択

する事も可能です。Normalizationの設定も個別に行う事ができます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

・ Export Peptide Report to Excel 

Proteins画面の上、Peptide Paneの内容に対する情報が、1タンパク質でなく Samples画面で  

表示されているすべてのタンパク質について CSV形式で出力されます。 

 

Fig.13-1  Export samples ダイアログ 
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・ Export Peptide Match Report to Excel 

Proteins 画面の中段、Peptide Match Paneの内容に対する情報が、1タンパク質でなく Samples

画面で表示されているすべてのタンパク質について CSV 形式（コンマ区切りのテキストファイル）で  

出力されます。「Export Peptide Report to Excel」と異なりファイル情報などは出力されません。 

 

・ Export Publish Report to Excel 

Publish画面、「Experiment Methods」タブの左側に表示されているパラメータの一覧情報が

CSV形式（コンマ区切りのテキストファイル）で出力されます。 

 

・ Export Workflow 

     検索時のパラメータファイルをまとめた「Workflow」ファイルを出力できます。New ボタンを押して 

データ取り込みを行う際に現れるダイアログ内にある「Save Workflow as …」ボタンと同じです。  

保存したファイルは別の解析で import する事もできます。別の解析で同じ検索条件を複数回適用  

したい場合に利用します。 

 

・ Run SQL Query for Export 

Publish 画面の「SQL Report」 タブ画面を開きます。 
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14. Prositとの連携によるライブラリフリーサーチ 

 

Scaffold DIA では検索の対象とするライブラリとして、Prositにより計算されたピークリスト並びに

保持時間情報を含むデータ(各関連資料にて”DLIB”と記載しています)の使用をお勧めしています。

PrositはWilhelmと Kusterのグループによって開発されたディープラーニングアルゴリズムです。

Scaffold 上で配列データベース(FASTA)を指定する検索と比較すると保持時間やピーク強度といった

予測値を持つことにメリットがあり、また DDAライブラリ検索と比較すると事前の DDA検索を必要

とせず、DDA結果にとらわれない（DDAで同定できなかったペプチドもターゲットとできる）点で  

メリットがあります。ただし DLIB検索では修飾パターンとして現段階ではシステインのカルバミドメチ

ル化(固定)しか考慮していない事にご注意ください。 

 

この章では、Scaffold DIAで使用する DLIBの取得方法について以下２つをご案内いたします。 

 

14-1. Proteome Software社が公開している DLIBファイルを利用する 

14-2. 準備した FASTAファイルを元に Prositを利用して DLIBファイルを作成する 

また取得した DLIBファイルについて、 

14-3. DLIB並びに FASTAファイルを Scaffold DIAにセットする方法 

 

もご紹介します。 

 

14-1. Proteome Software社が公開している DLIBファイルを利用する 

 

Proteome Software社にて、いくつかの生物種については事前に計算を行った DLIBファイルと  

対応する FASTAファイルを公開しています。作成パラメータは Tab.14-1の通りです。 

https://support.proteomesoftware.com/hc/en-us/articles/360035151172-Prosit-Derived-

Spectral-Libraries-for-Scaffold-DIA-Searches 

 

 

 

 

 

 

 

 

 

 

 

 

 

Parameter Setting 

Charge Range 2 - 3 

Maximum Missed Cleavages 1 

m/z Range 396.4 - 1002.7 

Default NCE 33 

Default Charge 3 

Tab.14-1 Proteome Software 社で公開している DLIB ファイルの Library 作成パラメータ 

https://support.proteomesoftware.com/hc/en-us/articles/360035151172-Prosit-Derived-Spectral-Libraries-for-Scaffold-DIA-Searches
https://support.proteomesoftware.com/hc/en-us/articles/360035151172-Prosit-Derived-Spectral-Libraries-for-Scaffold-DIA-Searches
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2022年 12月末現在、以下の生物種について準備しています (表記は公開サイトの内容に準ずる, 

Fig.14-1) 

Coronavirus （または plus Human）, Arabidopsis thaliana, Caenorhabditis elegans, Danio 

rerio, Drosophila melanogaster, Escherichia coli(strain K-12), Homo sapiens, Mus musculus,   

Rattus norvegicus, Saccharomyces cerevisiae 

利用したい生物種について、”DLIB”と”FASTA” を両方ともダウンロードしてください。 

取得したファイルを Scaffold DIA で利用する方法については、「14-3.DLIB並びに FASTAを

Scaffold DIAにセットする方法 (P.106)」をご覧ください。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.14-1  Proteome Software 社が公開している DLIB と FASTA 
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14-2. FASTAファイルを元に Prositを利用して DLIBファイルを作成 

 

Proteome Software社で予め準備されているDLIBは対象の生物種が限られています。また FASTA

エントリーの対象を Uniprot 内の reviewed (=Swissprot に相当)に限定しています。必要に応じて公開

されているもの以外の生物種を利用したり unreviewed (=TrEMBL に相当)を加えたいなどといった  

調整が必要な時、さらにはそれらとは全く別の FASTAファイルを利用したい時は、ご自身でDLIBを作成

することができます。作成の例として、Uniprot-reveiewed にて生物種 「Oryza sativa」に絞り込んだ 

データベースの作成についてご説明いたします。 

 

DLIB作成のステップは以下の通りです。 

14-2-1. FASTAファイルを取得する (例:Uniprotサイト) 

14-2-2. Scaffold DIAで Prosit用 のインプットファイルを作成する 

14-2-3. Prosit 公開サイトにてペプチド配列情報から計算を行う 

14-2-4. Scaffold DIAで Prosit出力ファイルと FASTAファイルから DLIBファイルを作成する 

 

以降、順にご説明します。 

 

14-2-1. FASTAファイルを取得する(例:Uniprotサイト) 

 

FASTA ファイルを準備します。FASTA はどこから取得したファイルでも使用可能ですが、Gene 

Ontology 情報に紐づけができるデータベースとして、Uniprot データベースの使用をお勧めしており、 

ここでは Uniprotサイトからファイルを取得する例をご紹介します。 

 

Uniprotに登録されているタンパク質が表示されます。 

 

Uniprotサイト（https://www.uniprot.org/）にアクセスし、Proteins をクリックします(Fig.14-2,赤丸)。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Fig.14-2  Uniprot サイト 

https://www.uniprot.org/


 ©2023  Scaffold DIA マニュアル マトリックスサイエンス株式会社 All Rights Reserved      96 

検索対象を reviewed,しっかりしたアノテーションがついているデータのみにしたい場合は「SwissProt」

あたりをクリックします(Fig.14-2,黄色枠)。Unreviewed、幅広いデータのみを対象としたい場合は

「Unreviewed」のあたり((Fig.14-2,赤色枠))をクリックします。選択しない場合は両方のデータベースが

選ばれている状態(Uniprotデータベース)です。 

 

 

 

 

また、左フレームにある「Popular organisms」で表記されている生物種に選択したい内容をクリック 

すると、該当生物種に限定されたタンパク質のみが表示されます。目的の生物種がリストにない場合、

Filter by taxonomy をクリックします（Fig.14-3 緑色枠）。 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.14-2  UniprotKB protein table 

Fig.14-3  UniProtKB 左フレーム拡大 
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生物種名を入力すると、候補が現れます。適切な内容を選択して Search ボタンを押すことで生物種の  

絞り込みが行われます(Fig.14-4)。 

 

 

 

生物種別のタンパク質リストに変わります。変更後のエントリー数は生物種別のタンパク質リストに    

変わります。変更後のエントリー数は左側の”Status”で（）内に表示されている数字や一覧の上の数字で

確認ができます(Fig.14-5 赤色枠)。使用に適切かどうかは、想定される生物種の遺伝子数と比較     

しながらご検討ください。 

 

 

Fig.14-4  taxonomy filter で適切な生物種を選択  

Fig.14-5  Filter 適用後の UniProtKB 
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内容を確認後、ファイル取得を行います。画面上部の「Download」(Fig.14-6)をクリックし、Format

として “FASTA(canonical)”を選択します。Compressed / Uncompressedはどちらでも結構です

が、  圧縮されている形式が Windows 標準では解凍できない”gz”ですので、それを解凍できる    

アプリケーションを持っていない方は”Uncompressed”を選択して下さい。 

全ての項目を選択後、「Download」ボタンを押すとファイル取得(ダウンロード)が実行されます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

[ 参考 ] 生物種情報を特定するために NCBIの Taxonomyサイトが利用できます。 

 

上記操作で「Popular organisms」で生物種を指定する際、名称の類似性などからターゲットとする対象

を限定するのが難しいケースがあります。Popular organisms の候補選択肢として現れる文字列の後ろ

に表示されている数字は NCBI の TaxID です。この数字について、NCBI の Taxonomy サイトにて    

事前に調べておくと候補の中から自らのターゲットとなる生物種を選びやすくなります。以下その操作に 

ついてご紹介します。 

 

 NCBIの Taxonomyサイト 

https://www.ncbi.nlm.nih.gov/taxonomy 

へアクセスします。 

Fig.14-6 UniProtKB の”Download” 

Fig.14-7 UniProtKB の”Download”オプション 

https://www.ncbi.nlm.nih.gov/taxonomy
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画面上部の検索枠で、生物種名による検索を行います。キーワードを入れて「Search」ボタンを押します

(Fig.14-8)。 

 

 

 

 

 

 

 

 

 

 

 

 

 

検索結果が表示されます。目的の生物種名のハイパーリンクをクリックします(Fig.14-9)。 

 

 

 

遷移画面にて、該当生物種の Lineage(系統)が表示されます。選択項目が正しい階層・属・種・株である

かを確認しながら、ターゲットとする項目のハイパーリンクをクリックします(Fig.14-10)。 

 

 

 

 

 

 

 

 

 

 

Fig.14-8 NCBI Taxonomy 検索欄 

 

Fig.14-9 NCBI Taxonomy 検索結果 

Fig.14-10 NCBI Taxonomy 検索結果 Lineage 表示 
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遷移画面にて、NCBIの Taxonomy ID をチェックします。以下図(Fig.14-11)であれば「4530」です。

この数字を記録しておき、Uniprotで生物種を特定する際の識別情報として利用してください。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

14-2-2. Scaffold DIA で Prosit用のインプットファイルを作成する 

 

FASTAを取得したら Scaffold DIAを起動し、menuの Tools -> Convert FASTA to Prosit CSV

を選択します(Fig.14-12)。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.14-11 NCBI Taxonomy 検索結果 各生物種の情報表示画面 

Fig.14-12 Tools -> Convert FASTA to Prosit CSV 
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FASTA を選択し(Fig.14-13)、パラメータはこだわりがない限り基本的にはデフォルト設定で「OK」 

ボタンを押してください。FASTAファイルと同じ場所に CSVファイルが作成されます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

＊ダイアログ内にも記載がありますように、この機能を利用され論文公開・学会発表をされた場合、リンク

が貼られている論文(Searle et.al 2020)の引用をお願いしています。 

 

 

14-2-3. Prosit公開サイトにてペプチド配列情報から計算を行う 

 

Prositのサイトへアクセスし、「SPECTRAL LIBRARY」をクリックします（Fig.14-14赤枠）。 

https://www.proteomicsdb.org/prosit/ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.14-13  Convert FASTA to Prosit CSV ダイアログ 

 

Fig.14-14  Prosit サイト 

https://www.proteomicsdb.org/prosit/
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Scaffold DIAで作成した Prosit用の CSVを指定するため「Next」ボタンを押します(Fig.14-15)。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

遷移画面にて画面左側のボタンをクリックし、Scaffold DIA で作成した CSV ファイルを指定してから

「Next」ボタンを押してください(Fig.14-16)。 

 

 

 

 

 

 

 

 

 

 

 

Fig.14-15  「Settings」選択内容 

Fig.14-16  Upload Files 選択項目 
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続いてピーク強度並びに保持時間の予測モデルの選択を行います。適切な内容を選び「Next」ボタンを 

押します。各モデルについての詳細は、論文 https://www.nature.com/articles/s41467-021-23713-9 

などをご参照ください（概ね名前から内容をご判断いただいて問題ないと思います）。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

出力のフォーマットを選びます。ここでは”Generic text”を選択して下さい (Fig.14-18) 。          

選択後”submit”ボタンを押すことで計算が実行されます。 

*フォーマットを.MSP にして、scaffold の変換で .MSP→ELIB を選択した場合も、作成後のファイルは目的の

DLIB と同じものができます。何らかのエラーなどにより以下ご案内する方法で DLIBが作成されない場合があ

りましたらそちらの迂回策をお試しください。 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.14-17  Model 選択項目 

Fig.14-18  Model 選択項目 

https://www.nature.com/articles/s41467-021-23713-9
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計算には時間がかかります。Task の ID が表示されますが、この TaskID の情報をどこかに残しておく

と、万が一ブラウザを閉じてしまった場合でも後でアクセスすることが可能です。 

例えば以下のように Task IDが示されている場合、 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

URLは以下の通りとなります（後ろの部分がタスクの IDです）。 

https://www.proteomicsdb.org/prosit/task/D907DA69FAC698CA2D23D4BDFBBC5144 

 

計算が終わると以下のようにファイル取得が可能となります。「Download」ボタンを押してください。  

ファイルは zip形式で圧縮されていますので、(windowsなら)右クリック→すべて展開、で解凍できます。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.14-19  Prosit サイト Task ID 表示 

Fig.14-20  Prosit サイト Task ID 表示 
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14-2-4. Scaffold DIA で Prosit出力ファイルと FASTAファイルから DLIBファイルを作

成する 

 

＊以降 14章では図の番号を省略します。 

 

Scaffold DIAを起動し、menuの Tools -> “Convert Prosit/Spectronaut CSV to DLIB”を 

選択します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

時間がかかる可能性がある旨警告するダイアログが現れます。「OK」ボタンを押してください。 

 

 

 

 

 

 

 

Prosit から得た CSV ファイルと、Uniprot サイトから取得した FASTA ファイルを選択して OK ボタン

を押します。 
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ファイル作成が開始します。以下ダイアログが消えるとファイル作成が完了しており、Prosit から出力され

た CSVファイルと同じ場所に DLIBファイルが作成されています(拡張子 :.dlib)。 

 

 

 

 

 

 

 

14-3. DLIB並びに FASTAファイルを Scaffold DIAにセットする方法 

 

 

Menu の File -> Open Library manager     

またはアイコンなどで  Library manager を   

起動します。 

 

 

 

“ Add Library” ボタンを押します。 

 

 

 

 

 

 

 

 

 

 

準備した DLIB ファイルを選択します。続いて、新たに表示された DLIB ファイルの行を選択した状態で

右クリック→“Associate with FASTA”を選択します。 
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DLIB と対になっている FASTA (あるいは Prosit で DLIB 作成時、最初に取得した FASTA)を     

選びます。 

 

 

 

 

 

 

 

 

 

 

 

 

Library Managerに追加 DLIBがセットされました。 

 

 

 

 

 

 

 

 

 

 

 

 

 

検索時に Library manager をご利用頂く事で、DLIBと FASTAの選択がスムーズになります。 
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15. Gene Ontology  

 

Scaffold DIAでは、各タンパク質の Gene Ontology の情報を結果画面に表示させる事が出来ます。  

また同定タンパク質リストの各タンパク質にアノテーションされた Gene Ontology情報をまとめて    

グラフ表示させる事ができます。Gene Ontology情報を適用させるためには、事前に関連ファイルを   

ダウンロードし Scaffold DIAに登録させる必要があります。 

 

15-1. Gene Ontologyファイルを Scaffold DIAにセットする方法 

 

Edit -> Edit GO term optionsで「GO Term Configuration」ダイアログを開きます。 

「GO Annotations」タブをクリックして画面を開きます(Fig15-1)。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

GO Annotationsタブでは、現在 Scaffold DIAでセットされている GOファイルが表示されます。 

新たな項目を加えるため、画面下部の「Import Annotations」ボタンをクリックすると、新たなダイアログ

[「Add GO Annotation Database」が現れます(Fig.15-2)。 

 

 

 

 

 

 

 

 

 

 

 

Fig.15-1  GO Annotations ダイアログ、GO Annotations タブ 

Fig.15-2  Add GO Annotation Database ダイアログ 
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Sourceの項目をクリックすると、一覧に取得可能な各種生物種/種類 の GOファイルが現れます。適切な

項目を選び「Add」ボタンを押すことで、ファイルのダウンロードならびに Scaffold DIAへのセットが自動

的に行われます。 

同一生物種で複数の種類がありますが、どれを選べばよいか判断がつかない時はとりあえず後ろに何も 

ついていない項目を選んでください。例えば Fig.15-3で Chickenであれば「goa_chicken」です。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

上記オプションは Scaffold DIAがオンラインの時でかつセキュリティ的にこの操作が問題ない時のみ使用

可能です。上記オプションが適用できない場合でも、必要なファイルを別の場所で取得し、Scaffold DIAに

セットする事も出来ます。取得したファイルをセットする時には「Choose file…」ボタンを押します。 

 

取得するべきファイルの場所については、Source で取得したい項目を選んだ際にその下に表示される

URLを参照してください(Fig.15-4、赤で囲われた部分)。 

 

 

Fig.15-3  Add GO Annotation Database ダイアログ 「Source」項目 

Fig.15-4  Add GO Annotation Database ダイアログ 「Source」項目 
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15-2. Scaffold DIAの各タンパク質に Gene Ontology情報を表示させる方法 

 

 15-1でセットした Gene Ontologyファイルの情報と同定タンパク質との紐づけと表示を行う事が   

出来ます。Gene Ontologyについては非常に多数の項目がある中で、ユーザーが事前にどの項目を表示

させるのかを選択しておく必要があります。 

 

 

15-2-1. 表示する GO項目を選択する 

 

Edit -> Edit GO term optionsで「GO Term Configuration」ダイアログを開き、「Displayed GO 

Terms」タブをクリックします。 

画面上部が Gene Ontologyの分類すべて、画面下部がその中でピックアップして Scaffold DIAで表示 

する項目となります(Fig.15-5)。 

 

 Fig.15-5  GO Term Configuration ダイアログ 「Displayed GO Terms」タブ 
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ツリー構造となっている GO情報から目的の項目を探し、その項目を選択した上で画面中央の”Add”   

ボタン(Fig.15-6,赤で囲われた部分)を押すと、下の”Selected GO Terms”項目へ移り、結果画面に該当

項目が表示されるようになります。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

逆に現在設定されている表示項目を外したい場合、その項目を選び”Remove”ボタンを押すことで    

実施できます(Fig.15-7)。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Fig.15-6  GO 項目の選択と Add ボタン 

Fig.15-7  GO 項目の選択と Remove ボタン 
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15-2-2. タンパク質と GO情報との紐づけを行う 

 

Edit -> Edit GO term optionsで「GO Term Configuration」ダイアログを開き「GO Annotations」

タブをクリックして、適用したい GOファイルを選択して「OK」を押してください(Fig.15-8)。 

 

 

 

 

 

 

 

 

 

 

 

続いて、Experiment -> Apply GO Terms ->Apply All annotations を選択すると、      

Gene Ontologyの情報が表示されます(Fig.15-9)。 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

GO情報の表示では、円のマークが全塗りと中が空いているものがありますが、これは情報の信頼度を

表します。全塗りのものは信頼度が高い、人間の実験者やキュレーターの確認を経ている情報で、中が  

空いているのはコンピューターのアルゴリズムによるアノテーションです。GOファイル内にある Evidence 

Fig.15-８  GO ファイルの選択 

Fig.15-9  GO 情報の表示[Samples 画面] 
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code 情報に基づいています。Codeとそれらを Scaffold DIAでどのように表示するかについては 

Tab.15-1をご覧ください。 

 

 

 

 

GO情報については、Samples画面で並べ直しを実施できるほか、Visualizeで項目をカウントした   

円グラフ、ならびにタンパク質と項目の関係性を表示した Connection graphを表示させる事も可能です

（8-2-4,P.73～）。 

 

 

 

 

  

Tab.15-1  GO 情報の Evidence のコードと Scaffold DIA での表示(Type of Circle) 
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16. デモデータと追加情報のご案内 

 

16-1. デモデータについて 

 

Scaffold DIA にはデモデータが準備されています。デモデータは  

Help -> Open Demo Files 

で開くことができます。 

 

 

 

16-2. Appendixについて 

 

本ソフトウェアを使用するにあたり、特に計算方法について付録として英文マニュアルに説明が      

ございます。ご不明な点がございましたらそちらの資料もご参照ください。 

 

Appendix A. Structure of Scaffold DIA files (*.sdia) 

Appendix B. Computation of FDR in Scaffold DIA 

Appendix C. Summarization : Rolling up Values 

Appendix D. Missing Values 

Appendix E. Shared Evidence Clustering Algorithm 

Appendix F. Heat map clustering 

 

Appendix G. Techniques to Control the Family-wise Error Rate 

Appendix H. Using Principal Component Analysis 

Appendix I. How PCA is Performed in Scaffold DIA 

Appendix J. Description of Mouse Right Click Context Menu Commands 
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16-3. EncyclopeDIAについて 

 

Scaffold DIA における、ペプチド同定や定量の中心的なプログラムは、「EncyclopeDIA」というフリーの

プログラムが担っています。EncyclopeDIAについては以下 URLをご参照ください。 

 

https://www.biorxiv.org/content/early/2018/03/07/277822 

https://bitbucket.org/searleb/encyclopedia/wiki/Home 

 

 

ご不明な点がございましたら、ご遠慮なくお問い合わせください。 

 

 

 

技術サポート  担当：高江洲（たかえす） 

 

電子メール ：support-jp@matrixscience.com 

電   話 ：03-5807-7897 

  ファックス ：03-5807-7896 

https://www.biorxiv.org/content/early/2018/03/07/277822
https://bitbucket.org/searleb/encyclopedia/wiki/Home

